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1 Getting Started with HP Center
Management for Quality Center

Overview of HP Center Management for Quality Center

Many IT organizations have adopted the Center of Excellence (CoE) model as
a practical way to improve IT operations consistently and continuously. In the
CoE model, the QA infrastructure, processes, and best practices are
consolidated and centralized to provide a management and automation
platform for application delivery, as well as leadership, consulting, and support
services to help companies optimize application quality. A CoE also provides
the entire organization with visibility into standardized quality metrics and key
performance indicators (KPIs). This helps to keep all stakeholders informed,
and keep applications aligned with business objectives.

HP Center Management for Quality Center (CMQC) uses the technology and
features of HP Project and Portfolio Management Center (PPM Center) to
optimize CoE management by introducing repeatable best practices, projects,
workflows, and key performance indicators (KPIs) for principal quality
activities.
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A Quality CoE can use CMQC to provide the following support services:

e Build and execute a project testing process, which involves:

(¢]

(¢]

(¢]

(e]

o

Set up a test strategy

Implement quality KPIs

Implement test management processes
Define a test plan

Automate test execution

e Optimize existing processes:

(¢]

o

(¢]

Determine the return on investment (ROI) of automating functional
testing

Integrate unit testing and functional testing processes

Measure and monitor the user experience

e Define and implement quality standards for:

(¢]

(e]

(¢]

Quality metrics
Quality processes

Quality management and automation technologies

All Quality CoE practices must be tightly integrated with all other upstream
and downstream application delivery processes. By increasing the
communication with the lines of business (LOBs) and exposing their processes
within the organization, the CoE can enable project teams to:

e Understand project interdependencies—how decisions made on one project
can affect other projects. Seeing the big picture helps team members meet
business goals, not just application goals.

e Lower costs by creating higher-quality applications. Application defects
and other issues are fixed before deployment.

Chapter 1



Distribute quality expertise around the organization by accelerating
knowledge transfer and sharing best practices. Knowledge is shared around
the organization, and stored for future projects.

Develop more generalized skills while honing expertise in areas of
specialty. Sharing both specific and general knowledge raises the level of
quality for applications, and of the organization.

Begin collecting and monitoring KPIs across the application lifecycle. This
data helps establish future quality metrics.

By involving both the LOB and Quality CoE members from the inception of
each project, and by encouraging feedback and collaboration at each stage,
organizations can achieve a truly business-oriented approach to application
delivery.

CMQC Functionality

CMQC includes functionality that enables you to:

Introduce and enforce consistent workflows for all major application
delivery processes

Initiate and manage application and testing projects
Gain (and provide) visibility into project and test status

Access automated Quality Center (QC) support and administration

In PPM Center, CMQC lets you:

Create projects based on templates and copy existing projects

Synchronize project configurations and customizations with another
project or template

Create a user accounts
Update user accounts
Reset user passwords

Add or remove users from a Quality Center project or security group

Gelting Started with HP Cenfer Management for Quality Center 77
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HP Center Management for Quality Center Roles and Responsibilities

To support the core quality processes, both the LOB and the Quality CoE
maintain dedicated staff, toolsets and templates, as well as documentation of
best practices, procedures, and techniques.

CMQC divides the roles into two groups; the LOB roles such as project
manager, developer, QA manager, tester, and the CoE roles such as
administrator or support engineer. These roles continuously interact to provide
seamless information and process flow between all groups involved in
application delivery. Figure I-1 shows the roles in the LOB and CoE groups.

Figure 1-1. LOB and CoE roles

/
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Program Project Business Practice Traine
Manager Managers Analyst Manager ramner
. AN / - J J
4 4 ™ 7 ™ ™
Development Nl S rt S rt
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Manager Developer Tier 1 Tier 2
>
. RN J - / J/
- ' ™ — 4 ™ ™
QA Manager QA Lead QA Tester QA Engineer M?]?l?gner ml:g
. J . J J
C JU JC JC || /
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Table 1-1 lists detailed descriptions of each LOB and CoE role.
Table 1-1. CMQC roles and responsibilities (page 1 of 2)

Team

Role

Description

LOB Project

Management Team

Program Manager

Manages one or more business
units and multiple projects.

Business Analyst

Manages business process
mapping, provides design reviews,
testing requirements, defines
business processes, and reviews
test scenarios and results.

Project Manager

Manages application projects and
the development lifecycle.

LOB Development

Team

Developer

Designs and develops application
and fixes defects.

Development Manager

Manages development project,
assigns defects to developers,
manages development priorities,
analyzes defect trends and root
cause.

LOB Quality

Assurance Team

QA Manager

Manages QA department (within
the LOB).

QA Project Lead

Performs software test planning,
risk analysis, design reviews, go/
no-go recommendations, test
scenario reviews, and so on.

Executes test scenarios, verifies

QA Tester and reports defects.
Performs testing coverage review,
provides business test design,
QA Engineer execution. Builds automated

scripts. Provides code reviews
and recommendations for
improving automation efficiency.

Getting Started with HP Center Management for Quality Center

13



Table 1-1. CMQC roles and responsibilities (page 2 of 2)

Team Role Description

Support Tier 1 CoE Support: Tier 1 Support

CoE Application Engineer
Support Team ST
Support Tier 2 goE_ Support: Tier 2 Support
ngineer
Administrative Manages the CoE infrastructure
Manager and applications

Provides administration for the

Product Administrator CoE infrastructure (Quality Center,

(QC)
CoE Administration PPM Center, and so on)
Team PPM Center Provides administration for the
Administrator PPM Server

Supports networking, the
System Administrator operating system, DBA and other
systems

Capturing and Tracking Demand

Users in an LOB can use CMQC predefined request forms to streamline and
automate the initiation of Quality CoE projects. Requests submitted from the
LOB follow a workflow that ensures consistency, visibility, and accountability
at each stage of the application delivery process. CoE personnel can perform
the required activities, track project status and progress, and report on the
quality level of any application at any point in the lifecycle.

Submitting Requests from the Line of Business

By following the workflows provided for projects, you ensure that each project
follows all required approval, review, and sign-off steps by all required roles.
The workflows and their layouts are designed to support automatic creation
and linkage between the PPM Center and Quality Center projects and follow a
standard software development lifecycle (SDLC) flow.

The workflows include a testing request that is assigned to a QA lead for
managing the testing processes and resources and gathering the quality

Chapter 1



metrics. The application project is managed by a project manager. A QA lead,
development lead, and an operations lead help drive the project to completion
through the key phases of the development lifecycle.

Incoming project initiation is handled by appropriate members of the Quality
CoE and routed through the CoE personnel for reviews and approvals as
specified in the workflow. Once the approval phase is complete, the CoE
manager can initiate a testing project using the quality process management
functionality of Quality Center.

CoE managers can use the portlets on personalized PPM Dashboard pages to
get a real-time view of proposed and in-flight testing projects and related
metrics. Figure 1-2 shows the Project Listing portlet, which displays relevant
statistics for ongoing projects.

Figure 1-2. Project Listing portlet
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Qa new Testing  User
Testing Project
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Shewing 1 te 10 of 11 Next| |1aximize

The Project Listing portlet is described in detail in Chapter 7, Viewing and
Tracking Project Progress and Quality, on page 101.

Gelting Started with HP Cenfer Management for Quality Center 15



Creating and Managing Quality Management Projects

CMQC provides project types for managing application and testing projects.
These requests are integrated with Quality Center to automate frequently
performed tasks or retrieve information.

A CoE project manager can use CMQC’s project types to create CMQC - QA
Testing Projects and CMQC - Application Projects. These projects are
designed for QA leads to manage the resources, progress, and key performance
indicators for their testing initiatives. With the testing project, you can:

e Use HP Project Management capabilities to manage the testing work plan
and associated tasks

e Use HP Resource Management to manage resources against project tasks

e Link PPM Center with Quality Center projects to manage test status and
key performance indicators

e Create an independent testing project, or link a project to an application
project to combine quality metrics with the general application project
status information.

A testing project follows a common testing workflow that includes test plan
design, test environment setup, detailed test plan and asset development, test
execution, periodic test status report generation, and final QA report
submission to all application stakeholders.

Reporting on Quality Metrics

Quality is a critical factor throughout the application delivery lifecycle. Status
reports are generated on an ongoing basis to give all stakeholders visibility into
application quality and progress of the QA efforts. This transparency is made
possible through the integration of Quality Center and PPM Center projects
and the test status report results available through various PPM Center portlets
(and through Cross-Environment Query and Quality Center User Query
reports).

Chapter 1



A test status report is linked to a single Quality Center project. It queries the
Quality Center project for statistics on requirements coverage, review status,
test execution status, and defect statistics. A series of test status reports for a
testing project are used for trending captured quality metrics.

Figure 1-3 shows a project status update report in the Project Status portlet.
This portlet provides an overview of current project status based on scope,
resources, schedule, risks, and issues.

Figure 1-3. HP Quality Center Project Status (CM) portlet

CMQC - Quality Center Project Status (CM)
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9 Tot:
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HP Center Management for Quality Center Administration Functions

A major role of the CoE revolves around administration and support activities.
CMAQC includes request types, project types, and workflows that support
actions related to the administration of the CoE itself, Quality Control, and IT
in general.

A Quality Center Administration request is a call for assistance with a
specified Quality Center instance or project, such as:

e C(Creating a new project based on a template

e Copying an existing project

Gelting Started with HP Cenfer Management for Quality Center 17



e Synchronizing project configurations and customizations with another
project

e C(Creating a user account

e Updating a user account

e Resetting a user account password

e Changing the users assigned to a Quality Center project or group

These requests are routed to the CoE administration or operations teams and
are handled by either an Quality Center administrator or a system
administrator. Unlike general support requests, these requests are specific to
Quality Center administration, and automate a predefined list of administrative
tasks.

All requests for general, administrative, or I'T support are handled by either an
application administrator for Quality Center, PPM Center administrator, or
system administrator. These requests focus primarily on application software
or hardware configuration, upgrades, installations, customizations, and so on.

CoE users can submit, view, and approve administration requests, as specified
in the workflow. Administration request activity can be viewed through
portlets distributed to the appropriate roles.

Supporting Quality Center Application Users

Users of quality assurance applications (such as HP Quality Center, HP
QuickTest Professional, HP WinRunner, and so on) can submit requests for
support. These requests, which typically revolve around application usability
and technical issues, are handled by the CoE support engineers. Feedback
provided by the requestor upon completion of the support request is channeled
to the CoE manager to ensure that support services are handled effectively.

Chapter 1



About the Documentation

Intended Audience

This document contains both administrative and end-user information. It is
written for the following:

System administrators responsible for installing and configuring HP Center
Management for Quality Center.

PPM Center administrators who sets up configurations within PPM Center.

Business users who need to view standardized quality metrics and key
performance indicators (KPIs) to keep applications aligned with business
objectives.

In this Document

If you are a system administrator who is responsible for setting up CMQC, see
the following sections:

For an overview of CMQC functionality and use, see Overview of HP
Center Management for Quality Center on page 9.

For information on system requirements for CMQC, see System
Requirements on page 23.

For information on what to consider and what tasks to perform before you
start to install CMQC, see Additional Installation Considerations

on page 24 and Before You Install HP Center Management for Quality
Center on page 25.

For installation instructions, /nstalling HP Center Management for Quality
Center on page 26.

For information on how to configure CMQC, see Configuring HP Center
Management for Quality Center on page 30.

Gelting Started with HP Cenfer Management for Quality Center 19
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If you are responsible for setting up configurations within PPM Center, see the
following sections:

For information on how to administer resources, see Chapter 4,
Configuring Resources for HP Center Management for Quality Center,
on page 39.

For information about CMQC application projects and how to create them,
see Chapter 6, HP Center Management for Quality Center Application
Projects, on page 75.

For information about CMQC testing projects and how to create them, see
Chapter 5, HP Center Management for Quality Center QA Testing
Projects, on page 49.

For information on how to monitor project progress and quality, see
Chapter 7, Viewing and Tracking Project Progress and Quality,

on page 101, Chapter 8, Project Status Update Requests and Test Status
Report Requests, on page 135, and Chapter 9, QA Test Status Reports,
on page 153.

For information on how to manage the administrative activities of a quality
center of excellence, see Chapter 10, Managing Quality Center of
Excellence Administrative Activity, on page 165.

Related Documentation

The following PPM Center documents provide additional information for
system administrators and PPM Center configurators:

Getting Started

Configuring the Standard Interface
Customizing the Standard Interface

HP Demand Management Configuration Guide
HP Project Management Configuration Guide
HP-Supplied Entities Guide

Chapter 1



Reports Guide and Reference
System Administration Guide and Reference
System Requirements and Compatibility Matrix

Release Notes

The following PPM Center documents provide additional information for
developers, quality engineers, and business users:

Getting Started

HP Demand Management User’s Guide
HP-Supplied Entities Guide

HP Project Management User’s Guide

Master Index

Getting Started with HP Center Management for Quality Center

2]
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2 Installing and Configuring HP Center
Management for Quality Center

Overview of Installation and Configuration
HP Center Management for Quality Center installation and configuration
involves the following:
e Performing preinstallation tasks
e C(CMQC software installation
e Configuring CMQC parameters on the PPM Server

This chapter provides information about the requirements for installing HP
Center Management for Quality Center, the tasks to perform before you begin
the installation, and detailed installation and configuration instructions. It also
includes a list of documents that are useful as you prepare to install CMQC.

System Requirements

To install and use CMQC version 2.00, you must have the following
components:

e HP Quality Center version 9.0 or 9.2

) If you are using PPM Center to manage multiple Quality Center instances, all of
the Quality Center instances must be of same version and patch level.

23



e HP Project and Portfolio Management Center (PPM Center) version 7.5 or

later, with the following conditions:

o Best Practices content must be installed on the PPM Center instance.

o The PPM Server must run on Microsoft® Windows® only.
VMware deployments are supported.

o If the Quality Center database uses Microsoft SQL Server, you must
have Oracle® Windows interfaces (for example, Oracle Provider for
OLE DB or Oracle ODBC) installed.

o PPM Server Web access must use Microsoft Internet Explorer 6.0
or 7.0.

Mozilla Firefox is not supported.

) For detailed information about PPM Center system requirements, see the PPM Center
System Requirements and Compatibility Matrix.

Additional Installation Considerations

24

Before you install CMQC version 2.00, be aware of the following:

If you are working with multiple servers in a clustered environment, you
must install CMQC on each server node in the cluster, and provide the
identical configuration parameter values for each.

If you are using PPM Center to manage multiple Quality Center instances,
all of those instances must be at the same version and patch level.

You cannot upgrade from (PPM Center version 6.0-based) CMQC version
1.0 to (PPM Center version 7.5-based) version 2.00. If you have version
1.0 installed, you need assistance from HP Software Support to upgrade to
version 2.00.

CMQC version 2.00 is available in English only. Other languages are not
yet supported.
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e To use the request types, workflows, and project types that CMQC
provides, ensure that you have user product licenses for HP Demand
Management and HP Project Management.

For detailed information about licenses for HP Demand Management and HP

) Project Management, see the PPM Center Security Model Guide and Reference
the HP Demand Management Configuration Guide, and the HP Project
Management Configuration Guide.

Documentation Related to HP Center Management for Quality Center System
Requirements

For information on the tasks related to installing and configuring PPM Center
and Quality Center, see the following documents:

e For information on the system requirements and procedures for installing
HP Quality Center, see the HP Quality Center Installation Guide.

e For information on the system requirements for installing PPM Center, see
the System Requirements and Compatibility Matrix. For information about
how to install PPM Center, see the System Administration Guide and
Reference.

e For information about the specific versions required for third-party
software, see the PPM Center System Requirements and Compatibility
Matrix.

Before You Install HP Center Management for Quality Center

Before you begin to install CMQC, perform the following tasks:

1. Ensure that you can connect to your PPM Center Oracle database instance
from the command line using SQL*Plus.

2. If you cannot connect to your PPM Center Oracle database instance, add
the oracle bin directory to the path, and then verify that you can connect

to your PPM Center Oracle database instance from the command line using
SQL*Plus.

Installing and Configuring HP Center Management for Quality Cenfer 25



3. Set the DB__CONNECTION STRING server configuration parameter to the
PPM Center Oracle Database TNS name. (The TNS name typically
matches the Oracle SID, although there are exceptions.)

CMQC uses the DB CONNECTION STRING parameter to set up scripts that
) upload required data and SQL procedures into the PPM Center database. For

information on how to modify this and other PPM Center server configuration

parameters, see the PPM Center System Administration Guide and Reference.

Installing HP Center Management for Quality Center

To install CMQC:

1. Update database settings for the KINTANA SERVER environment object, as
follows.

0 If the database connection information is not correctly specified for the default
environment, much functionality can be lost and errors may occur.

a. Log on to PPM Center.

b. From the menu bar, select Open > Administration > Open Workbench.
The PPM Workbench opens.

c. From the shortcut bar, select Environments > Environments.
The Environment Workbench opens to the Query tab.

d. Click List. and then, on the Results tab, double-click KINTANA _
SERVER.

If the KINTANA SERVER environment object does not exist, you must create it.
0 For instructions on how to create an environment in PPM Center, see the HP
Deployment Management Configuration Guide.
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The Environment window opens to the Host tab and displays the
KINTANA_ SERVER environment settings.

D Environment : KINTANA_SERVER

Environment Mame: \KINTANA_SERVER | Description: |ier and database hosting the PPM application server
Location: ‘ | Enabled: (%) Yes (@]
Host ]Applicat\ons] ] Ownarsh\pl User Access} }
Server Enable Server:
Mame: | ppmicon03p.hp-mms.cam Type: |Wmd0ws Server V‘

Username: | CustornerDey Password; [+wwes [9

Cannection Protacal; ‘Telnet V‘ TransFer Pratacel; |FTP v‘

NT Domain: | Base Path: |dUPFMMMS_FROD ]
Client Enable Client:
Mame: ‘ ‘ Type: | ‘ D
Username: ‘ ‘ Password: | |
NT Domain: | | Base Path: | |
Connection Protocal: ‘ ‘ Transfer Protocal: | ‘
Database Enable Datahase:
Server Type: |[o
Host Name: |PPMMetro04 | Connect string: [PPM10. |
Username: ‘cmq:bdg? ‘ Password: |ﬁ'ﬁ'?-' |E]
Oracle SID0 | MG 20200 | Port Humber: 1571 |
DB Link: ‘ ‘ Wersion: | |
JDBC_URL jobicaraclethin @ityacesnd 1521 ppr O] |

Ready

e. To the right of the Database section, select the Enable Database
checkbox.

f. In the Database section, update the database settings for the
environment.

If the JDBC_URL parameter is already defined in your <PPM Home>\
) server.conf file, then, in the JDBC URL field, reference the JDBC
connection string using the token [AS.JDBC_URL] .

2. Obtain the CMQC installation bundle (mitg-800-CcMQC. jar).
3. Copy the mitg-800-cMQC. jar file to the <pPM Home> directory.

where <PpPM Home> represents the path where your PPM Center instance is
installed. For example: xyzserver/E/PPMServer.

4. Run the kDeploy.sh script (located in the <pPPM Home>\bin directory), as
follows:
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sh ./kDeploy.sh -i CMQC

. Provide your PPM Center username and password, as prompted.

. To update the PPM Server configuration, run the kUpdateHtml . sh script,

which is located in the <PPM Home>\bin directory.

. Stop, and then restart the PPM Server.

JSR-based portlets are not registered with PPM Center until you restart the PPM
Server. For information on how to start and stop the PPM Server, see the System
Administration Guide and Reference.

After installation is complete, the installer displays a message to indicate
that CMQC was successfully installed and lists the entities installed. Each
entity that was installed correctly is marked “Complete.”

. If installation errors occur, correct them, and then repeat step 4 through

step 7.

. Because some of the interaction between Quality Center and PPM Center

occurs through the QC client code, you must enable Quality Center
connectivity by installing the QC client-side component on the PPM
Server.

If you later install a Quality Center service pack, or you upgrade Quality Center,
you must then re-enable Quality Center connectivity.

To install the QC client-side component on the PPM Server:

a. On the Microsoft Windows computer hosting the PPM Server, open a
browser window, and navigate to Quality Center:

<QC Server>:<Port>/qcbin

where <0C_server> represents the name assigned to your Quality
Center server during installation, and <Port> represents the port
number used to connect to the Quality Center server. For example,
http://xyz.company.com:8080/qcbin.

This corresponds to the KINTANA SERVER NAME server configuration
parameter value and does not necessarily reflect the actual host name of
the server.
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b. Select the link for Quality Center to download and install the user site
ActiveX controls.

c. Select the link for Site Administration to download and install the
Quality Center Administration ActiveX controls.

Downloading the ActiveX controls also downloads and installs the
required libraries for Quality Center OTA interfaces (TD Client and SA
APIs).

d. Validate Quality Center connectivity, as follows:
i. Open a command prompt window
i. Change to the <PPM Home>\ext\gcm\scripts directory.
i. Execute the following command:

cscript.exe /nologo gcm gc ListOfDomains.vbs
<QC URL Address> <QC User> <QC Password>

where <0C URL Address> is the URL of the Quality Center target
instance, <oCc User> is the Quality Center username used to log on
to the QC instance, and <oC Password> is the password for the
Quality Center username.

Example:

cscript.exe /nologo gcm gc ListOfDomains.vbs
http://xyz.company.com:8080/gcbin testuser testpwd

The script output lists all domains to which the specified user has
access.

All Quality Center-related portlets (for example, QC Project Status, QC
User Query) reference data in the Quality Center USERS PROJECTS
table.

Registering Your Quality Center Instance

After you install CMQC, you must register your Quality Center instance to
enable CMQC functionality. For detailed instructions on how to register a
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Quality Center instance, see Quality Center Instance Registration Requests
on page 165.

Configuring HP Center Management for Quality Center

CMQC uses PPM Center technology to trigger email notifications when
certain workflow events occur during the request lifecycle. These notifications
contain parameters defined in the PPM Center server. conf file.

This section provides descriptions of these configuration parameters, which
you must add manually to the server.conf file and then modify to reflect the
names and identifiers of your organization’s naming conventions.

The server.conf file contains the values of all of the server parameters when
the server configuration utility was last run. The server.conf file is
automatically regenerated by the configuration utility.

To edit the server.conf file:

1.

30

Back up your server.conf file, which is located in the <pPpPM Home>
directory.

Run the kstop. sh script to stop the PPM Server:

sh ./kStop.sh

Open the server. conf file in a text editor, and then add and specify values
for the parameters listed in the following table.

The parameter names listed in this table are shortened versions of the actual
names, all of which start with the string com. kintana.core.server. For
example, the full name of the CMQC SUPPORT REQUEST ID parameter is
com.kintana.core.server.CMQC SUPPORT REQUEST ID. Toadda
parameter to the server.conf file, you must use its full name.
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Parameter Name

Description

CMQC_DELIVERY_CENTER

Name of the QA team or QA Center of
Excellence that uses CMQC to provide QA
services to the development team

CMQC_DELIVERY_MANAGEMENT

Name of the group that leads the QA team

CMQC_ITSUPPORT_REQUEST _ID

IT or administrative service request (ASR)
identifier

CMQC_ITSUPPORT_CENTER

Name of IT or administrative center or
division

CMQC_ITSUPPORT_TEAM

Name of the IT or administrative team

CMQC_MAX_ALLOWED_
PROJECTS

Number of projects that a user can select

for querying and viewing in the following

portlets:

e CMQC - Quality Center Defects (CM)

e CMQC - Quality Center Project Status
(CM)

e CMQC - Quality Center Requirements
(CM)

e CMQC - Quality Center User Query (CM)

Restricting the number of selectable

projects in these portlets helps improve

performance.

CMQC_STATUS_UPDATE_ID

Status update identifier

CMQC_SUPPORT_CENTER

Name of the product support center or
division

CMQC_SUPPORT_REQUEST_ID

Support request identifier

CMQC_SUPPORT_TEAM

Name of the product support team

4. To regenerate the server.conf file and propagate the changes, run the
kUpdateHtml.sh script from the <PPM Home>\bin directory.

5. Run the kstart.sh script to restart the PPM Server.

sh ./kStart.sh

Installing and Configuring HP Center Management for Quality Cenfer
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Running a Server Configuration Report

You can view a list of the server configuration parameter values on an active
PPM Server by running the Server Configuration report.

To run the Server Configuration report:
1. Log on to PPM Center.
2. From the menu bar, select Open > Administration > Open Workbench.
The PPM Workbench opens.
3. From the shortcut bar, select Sys Admin > Server Tools.
The Admin Tools window opens.
4. From the list at the top of the window, select Server Configuration Report.

5. Click Submit.

What's Next?

After you install and configure CMQC, you can examine the HP-supplied
content that comes with the product and customize it for your organization.
This is covered in Chapter 3, Setting Up HP Center Management for Quality
Center, on page 33.
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3 Setting Up HP Center Management for
Quality Center

Overview of HP Center Management for Quality Center Setup

Before you can get started using the newly-installed CMQC, you must perform
the following required tasks:

Create PPM Center users and assign these users to CMQC security groups
based on their roles and responsibilities. For complete instructions on how
to set up user accounts and assign users to security groups, see Chapter 4,
Configuring Resources for HP Center Management for Quality Center,

on page 39.

Register your HP Quality Center instance(s). For complete instructions on
how to register your Quality Center instances, see Quality Center Instance
Registration Requests on page 165.

In addition to these required tasks, there are several ways in which you can
customize CMQC content.

For example:

e Some CMQC fields contain generic values, which you can change (using

the provided CMQC validations) to reflect your organization’s naming
conventions and processes.

You can create simple HTML form elements, or banners, to add
eye-catching color and graphic complexity to your request type forms.
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® You can create requests that trigger email notifications to be sent to
specific users at different steps along a workflow. The email notifications
contain fields that you can modify to fit your organization’s naming
conventions.

e To streamline the user experience for the Quality CoE and LOB users, you
may want to disable certain request types, workflows, or other entities that
are not part of the quality process.

Before you disable any entities, be sure to check with other business units that
may be using PPM Center. For information on how to disable a request type, see
the HP Demand Management Configuration Guide.

Customizing HP Center Management for Quality Center

34

Although the request types, workflows, project types, and work plan templates
delivered as part of CMQC are ready to use immediately after installation and
system-level configuration, you can configure the product further to better suit
your organization’s requirements. The following sections provide information
on how to do this.

Customizing Field Values

PPM Center field types and values are controlled by validations. To determine
the list of possible values for a field, you edit its validation (change, add, or
remove a validation value) from the PPM Workbench.

Although you can modify any validation listed in the Validation Workbench,
HP strongly recommends that you only modify those that are explicitly
described as “Customizable.” Modifying other validations (for example, those
described as “Static,” “AutoComplete,” or “Workflow”) can interfere with
CMQC functionality.
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CMQC provides the following customizable validations:

e (CMQC CMN KPI Status. This is used to validate status values in
drop-down lists (for example, the Overall Quality Status, Coverage Status,
Defect Status, and Test Status lists on the CMQC - QA Test Status Report
configuration page).

e CMQC CSR ITSERVICE CAT SUB TPC_LIST. This is used to
validate items in the Categories, Subcategories, and Topics drop-down lists
for IT service requests. You can specify all the token codes for these lists
using only this validation.

The following example procedure shows how to add values to a validation list:
1. Log on to PPM Center.
2. Select Open > Administration > Open Workbench.
The PPM Workbench opens.
3. From the shortcut bar, select Configuration > Validations.
The Validation Workbench opens.
4. On the Query tab, click List.
The Results tab displays the search results.

5. Scroll to, and then double-click CMQC_CSR_ITSERVICE_CAT_SUB_TPC_
LIST.

The Validation window opens and lists the validation values for the
Category, Subcategory, and Topic lists for CMQC - IT Service Requests.
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Validation : CMQC_CSR_ITSERVICE_CAT_SUB_TPC_LIST

Mame: [1QC_CSR_ITSERVICE_CAT_SUB_TPC_LIST|| Refarence Code:|[1QG_CSR_ITSERVICE_CAT_SUB_TPC_LIST|

Description ‘nizable) CMQC Serivce Request Consolidated list of categories, subcategories and topics for IT senice request‘

Enabled Use in Workflow? ]
Component Type [Drup Down List -
validated By: List ~
Validation Values:

Seq Code Meaning Description Enahled| Defau
1|CAT_QC Quality Center Issues relating to Quality Center il I -
2ICAT_ITG IT Governance Issues relating to IT Governance [ I
3|CAT_PC Performance Center  |Issues relating to Performance Center [ I
4|CAT_OTHER Other Al otherissues il il
5|SUB_QC_IMS Installation Issues relating to installation il il
GSUB_QC_CFG Configuration Issues relating to configuration [ I
TISUB_QC_NET Metwarking Issues relating to networking [ I
8[SUB_QC_HW Hardware Issues relating to hardware i I
9/SUB_QC_05 Qperating System Issues relating to operating system Y i

10|5UB_QZ_ADMIM Administration Issues relating to administration [ R -
4 = [ T»

‘Ready

6. Click New.

The Add Validation Value window opens to the Value Information tab.

Add Validation Value ]

Walue Information l Lser Data }

Code: || |

Meaning: | |

Desc: | |

Enable? Default: ]

Lok J[ aaa ][ cancel

Ready
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7. Complete the fields as described in the following table:

Field Name

Description

Code

Type the underlying code for the new validation
value.

Note: The code is the value stored in the database
or passed to any internal functions, and is rarely
displayed.

Meaning

Type the meaning of the value for display.

Desc

Type a short description of this value.

Enable?

To enable the validation value, leave this checkbox
selected.

Default

To make this value the default value in the list, select
this checkbox.

Note: The Default checkbox is only available for
drop-down lists.

8. The CMQC_CSR

ITSERVICE CAT SUB_TPC _LIST validation has

two user data fields (Type and Parent), which you configure as follows:

a. Click the User Data tab.

b. In the Type list, select the name of the list to which you want to add the

new value.

c. In the Parent list, specify the parent token code to which a subcategory
or topic belongs.

9. To close the window and add the value to the validation, click OK.

10. To change the order in which a value is displayed in the list, in the
Validation Values table, select the value, and then use the up and down
arrows to change its position.

11. After you finish adding values to the validation, click OK.

Use caution as you create validations that are validated by lists. You must update
) a validation every time its values set changes. Instead, consider validating using a
SQL query or PLSQL function to obtain the values from a database table.

For detailed information on how to create and edit validations in PPM Center,
see the Commands, Tokens, and Validations Guide and Reference.
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Documentation Related to Customizing HP Center Management for Quality

Center Entities

CMQC delivers request types, workflows, portlets, PPM Dashboard modules,
and work plan templates as best practice content. You can use these entities
immediately after installation, or tailor them to better fit your organization’s
business practices and procedures.

The following documents provide information on how to customize HP PPM
Center entities:

38

Configuring the Standard Interface
HP-Supplied Entities Guide

HP Demand Management Configuration Guide
HP Portfolio Management Configuration Guide
HP Program Management Configuration Guide
HP Project Management Configuration Guide
HP Time Management Configuration Guide
Reports Guide and Reference

Commands, Tokens, and Validations Guide and Reference
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4 Configuring Resources for HP Center
Management for Quality Center

Configuring Resources

All LOB and Quality CoE members who require access to CMQC must be
defined as users in PPM Center.

To give a resource access to CMQC, you perform the following tasks:

1.

Create a user account for the resource in PPM Center.

For detailed instructions on how to create PPM Center user accounts, see
the Security Model Guide and Reference.

Before you create your user accounts in PPM Center, be sure to read Creating
PPM Center User Accounts.

Assign the user to one or more security groups based on his or her role.

Instructions for adding users to security groups are available in the Getting
Started guide. However, before you perform this task, be sure to read Linking
Users to Security Groups first.

Assign licenses to the user based on the license requirements of the
security group.

For detailed instructions on how to create PPM Center user accounts,
create security groups, assign users to security groups, and how to assign
licenses, see the Security Model Guide and Reference.
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4. Configure the appropriate PPM Dashboard pages for security groups.

For instructions on how to configure PPM Dashboard pages, see the
Getting Started guide.

Creating PPM Center User Accounts
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Both PPM Center and Quality Center have their own user management
systems. The login name for a given user must be the same in PPM Center and
in Quality Center.

The PPM Center portlets that pull information from Quality Center use the
PPM Center user's login name to determine which Quality Center project that
login name can access. If the PPM Center user login name does not exist in
Quality Center, then PPM Center cannot access the information in the Quality
Center portlets.

Both PPM Center and Quality Center support LDAP integration. To ensure
that both applications have the same accounts and access grants, HP strongly
recommends that you use either LDAP or Active Directory services with each
to manage accounts. Using LDAP for user authentication also facilitates
compliance with SOX and other regulations.

PPM Center provides the ability to import and validate user data from the user
interface tables or from an LDAP server into the PPM Center user data model. This
report runs the user open interface. For more information about this report, see the
Open Interface Guide and Reference.

For detailed instructions on how to create PPM Center user accounts, see the
Security Model Guide and Reference.

Before you create your PPM Center user accounts, ensure that you have
configured the validations PPM - Department - Enabled and CRT - Company
to suit your business needs.
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Linking Users to Security Groups

CMQC users can be grouped into one of two categories: the LOB users, and
the CoE users. LOB users have the role of project manager, developer, QA
manager, tester, and so on. CoE users can perform the role of administrator or
support engineer, for example.

Each role is represented by a PPM Center security group. Each security group
has its own permissions and access grants that enable users in different roles to
access information that relates to the quality process.

CMAQC users must belong to at least one of the security groups listed in
Table 4-1, and to at least one of the groups listed in Table 4-2.

Table 4-1. Required security groups

PPM Center Security Group | User

CMQC CORE USERS

Users who belong to a CoE-type security group
must be assigned to this security group.

CMQC ALL USERS

All CMQC users must be assigned to this security
group. Some views are only visible to users who
belong to this group.

Table 4-2 lists descriptions of the security groups to which you can assign
users, the license(s) linked to the security group, and the CoE teams to which
members of the security groups might typically belong.

Table 4-2. Security groups and roles (page 1 of 2)

Team Security Group/Role Licenses
CMQC - Program Manager PM2, RMP, DM®
LOB - Project CMQC - Business Analyst PM, DM
Management Team
CMQC - Project Manager PM, RM, DM
LOB - Development CMQC - Developer PM, DM
Team CMQC - Development Manager PM, RM, DM

Configuring Resources for HP Center Management for Quality Center 4]



Table 4-2. Security groups and roles (page 2 of 2)

Team Security Group/Role Licenses
CMQC - QA Manager PM, RM, DM
LOB - Quallty CMQC - QA PrOjeCt Lead PM, DM
Assurance Team CMQC - QA Tester PM, DM
CMQC - QA Engineer PM, DM
CoE - Application CMQC - Support Tier-1 DM
Support Team CMQC - Support Tier-2 DM
CMQC - Administrative Manager U9, ce
CMQC - Product Administrator PM. DM
CoE - Administration (Quality Center) ’
Team
CMQC - PPM Administrator uU,C
CMQC - System Administrator DM

© 2 0o T o

PM represents the Project Management license
RM represents the Resource Management license
DM represents the Demand Management license
U represents the User Administration license

C represents the Configuration license

Configuring User Resource Information
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testing suites, design test plans, software architect).

You can assign a user to security groups using the Security Groups tab in the
User window or through an organization model defined in PPM Center.

A resource is a person who performs work tracked by PPM Center. Resources
can include employees, contractors, managers, or any other category your
organization may need. Each user is treated as a resource in PPM Center. For
each user, you can capture information specific to that resource, such as:

e Skills. The main duties or abilities of the user (such as develop automated
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e Roles. Resource descriptions (such as resource manager, program
manager, resource, portfolio manager) based on resource responsibilities.
Roles are assigned specific permissions.

e Cost Rate. The hourly cost associated with a resource or skill. This rate
represents the charge-back or billed labor cost.

e Workload Capacity. The percentage of a resource's working day that is
available for planned workload items. For instance, a particular DBA may
be required to participate in meetings every day, and, therefore, is set to
devote 80% of her capacity to workload items.

For information on how to configure resource information in PPM Center, see
the HP Resource Management User’s Guide.

Setting Up Contact Information

Contacts are resources who are used as points of reference or information.
Contacts must have a valid PPM Center username, and the company for which
they work must be included in the validation CRT - Company validation.

) For information on how to configure validations in PPM Center, see the Commands,
Tokens, and Validations Guide and Reference.

You can configure contact information for any individual, regardless of
whether he is or is not a PPM Center system user. For information on how to
configure contacts, see the HP Demand Management Configuration Guide.

Delivering Role-Based PPM Dashboard Views

CMQC provides a number of PPM Dashboard modules that provide essential
information based on the user role in the quality process. Each module
corresponds to the security group with the same name (for example, a CMQC
QA Manager security group member would get the CMQC - QA Manager
module) and includes preconfigured pages that contain sets of portlets specific
to each role.
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Table 4-3 lists the PPM Center security groups and the CMQC modules
designed for viewing by members of these groups.

Table 4-3. Security groups and corresponding PPM Dashboard modules

PPM Center Security Group

PPM Dashboard Module

CMQC Program Manager

CMQC - Program Manager

CMQC Project Manager

CMQC - Project Manager

CMQC Business Analyst

CMQC - Business Analyst

CMQC Development Manager

CMQC - Development Manager

CMQC Developer

CMQC - Developer

CMQC QA Manager CMQC - QA Manager
CMQC QA Project Lead CMQC - QA Project Lead
CMQC QA Tester CMQC - QA Tester
CMQC QA Engineer CMQC - QA Engineer
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Table 4-4 shows the default role-based distribution of PPM Dashboard pages
to teams. It also lists the portlets these preconfigured pages contain. For
detailed descriptions of the portlets listed in this section, see Chapter 7,
Viewing and Tracking Project Progress and Quality, on page 101.

Table 4-4. PPM Dashboard pages and role-based portlet content (page 1 of 4)

Team

Role

PPM
Dashboard
Page

PPM Dashboard Portlets

LOB - Project
Management
Team

Program
Manager

Front Page

e CMQC - Business Value Map
e CMQC - Project Listing

e CMQC - Web Frame Portlet
(CM) - Business Service
Levels

e My Requests
e Project Gantt
e My Tasks

Quality
Mgmt

e CMQC - Quality Center Project
Status (CM)

e Project Health Pie Chart

e CMQC - Defects Breakdown
by Status (#)

e CMQC - Defect by Status
Trending

e CMQC - Requirement
Coverage by Status

e CMQC - Requirement
Coverage Trending (%)

Service
Mgmt

e CMQC - Web Frame Portlet
(CM) Business Availability
View

Resource
Mgmt

e CMQC - Skillset Coverage
e Analyze Resource Pools
e Resource Pool List

Configuring Resources for HP Cenfer Management for Quality Center
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Table 4-4. PPM Dashboard pages and role-based portlet content (page 2 of 4)

PPM
Team Role Dashboard | PPM Dashboard Portlets
Page
e CMQC - Project Listing
e My Requests
Front Page .
Business e Project Gantt
Analyst e My Tasks
Project e CMQC - Quality Center Project
Mgmt Status (CM)
e CMQC - Business Value Map
e CMQC - Project Listing
Front Page e My Requests
e Project Gantt
e My Tasks
. e CMQC - Quality Center Project
LOB - Project Status (CM)
Management ) .
Team e Project Health Pie Chart
e CMQC - Defects Breakdown
by Status (#
. Quality y us (#)
Project e CMQC - Defect by Status
Mgmt .
Manager Trending
e CMQC - Requirement
Coverage by Status
e CMQC - Requirement
Coverage Trending (%)
Service e CMQC - Web Frame Portlet
(CM) Business Availability
Mgmt .
View
e CMQC - Skillset Coverage
Resource
M e Analyze Resource Pools
gmt

e Resource Pool List
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Table 4-4. PPM Dashboard pages and role-based portlet content (page 3 of 4)

PPM
Team Role Dashboard | PPM Dashboard Portlets
Page
Front Page e My Requests
e My Tasks
Developer Y
Quality e CMQC - Web Frame Portlet
Center (CM) - Quality Center View
e CMQC - Project Listing
e My Requests
- Front Page
IE)Z\I?eIo ment g e Project Gantt
Team P e My Tasks
Development | Quality e CMQC - Quality Center Project
Manager Mgmt Status (CM)
Quality e CMQC - Web Frame Portlet
Center (CM) - Quality Center View
Resource e CMQC - Skillset Coverage
Mgmt
e CMQC - Project Listing
Front Page e My Requests
e My Tasks
e Project Gantt
e CMQC - Quality Center Project
LOB - Quality Status (CM)
Assurance QA Manager Quality * CMQC- Requwemen:
Team Overview Coverage Trending (%)
e CMQC - Defect by Status
Trending
Quality e CMQC -Web Frame Portlet
Center (CM) - Quality Center View
Practice e CMQC - Skillset Coverage
Mgmt

Configuring Resources for HP Cenfer Management for Quality Center
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Table 4-4. PPM Dashboard pages and role-based portlet content (page 4 of 4)

PPM
Team Role Dashboard | PPM Dashboard Portlets
Page
e CMQC - Project Listing
e My Tasks
Front Page
QA Project e My Requests
Lead e Project Gantt
Quality e CMQC - Web Frame Portlet
Center (CM) - Quality Center View
LOB - Quality e My Requests
Assurance Front Page e My Tasks
Team QA Tester
Quality e CMQC - Web Frame Portlet
Center (CM) - Quality Center
My Requests
Front Page * VyRed
e My Tasks
QA Engineer
Quality e CMQC - Web Frame Portlet
Center (CM) - Applications Under Test

For instructions on how to configure PPM Dashboard modules, see the
Configuring the Standard Interface guide.
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5 HP Center Management for Quality Center
QA Testing Projects

Overview of CMQC - QA Testing Projects

The QA Testing Project request type is designed to help QA managers govern
their testing projects. Using PPM Center's project and resource management
capabilities, a QA lead can generate work plans, allocate resources, track
progress, and create key performance indicators for all of their testing
initiatives.

A QA testing project provides the following key capabilities:

You can use HP Project Management to manage testing, work plans, and
associated tasks.

Use HP Resource Management to assign resources to specific project tasks.

Use your Quality Center project data to review test status and application
performance indicators.

In addition, each CMQC - QA Testing Project:

Comes with a sample work plan, many useful fields, and its own workflow
Serves as a collection point for QA Test Status reports

Can be used to collect historical trending data (through QA Test Status
reports)

Provides a single view into QC data. This view is similar to a Quality
Center “favorite,” which includes a subset of QC project data.

You can create a CMQC - QA Testing Project as an independent project, or
link it to a CMQC - QA Application Project to combine data on the quality
assurance activities with the application project status.
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Creating a CMQC - QA Testing Project

50

To create a testing project:

1. Log on to PPM Center.

2. From the menu bar, select Open > Center Management > Quality
Management > Initiate Testing Project.

The Create New Project page opens.

Create New Project

Project Hame:

Project Type:

Project Manager: Admin User
Planned Start Period:

Planned End Period:

Region: Enterprize

i [ [

N B

Create

3. Complete the following fields:

Field Name
(*Required)

Description

*Project Name

Type a name for the project in this field.

*Project Type

From the auto-complete list, select CMQC - QA
Testing Project Type.

*Project Manager

From the auto-complete list, assign a resource other
than the default (your name) as project manager.

*Planned Start
Period

From the auto-complete list, select the calendar
period (month and year) during which you expect the
project to start.

*Planned End
Period

From the auto-complete list, select the calendar
period (month and year) during which you expect the
project to end.

*Region

From the auto-complete list, specify a region (other
than the default) to associate with the project.
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4. Click Create.
The Create New CMQC - QA Testing Project page opens.

?| Help with CMOC - QA Testing Project

Create New CMQC - QA Testing Project

= Testing Work Plan

*Test Requirements:

Submit Cancel

= Header
= Instructions

& Use this project request to manage the testing process.

& The fields with * require your input.
® Summary
= PFM Project
= Details

“Application: “Version: I:l

“Test Scope: ‘ | i
Test 5tatus Report Request Type: | Q
# Testing Requirements
# MNotes
Submit Cancel

HP Cenfer Management for Quality Center QA Testing Projects
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5. In the Testing Work Plan section, complete the following fields:

F‘EEeqli?:c]()a Description

*Application Type the name of the application under test in this field.

*\Version Type the version of the application under test in this
field.

*Test

Requirements

Type a summary of the testing requirements in this field.

*Test Scope

From the auto-complete list, select one or more items
(for example, Requirements Testing, Unit Testing,
Security Testing, and so on) to reflect the entire scope
of the testing effort for this project.

Test Status
Report Request

Type

From the auto-complete list, select a status report
request type to use to provide an overview of testing
requirements.

To view descriptions of the remaining (optional) fields on this page, click the Help
with CMQC - Testing Project link at the top left of the page.

6. (Optional) For each of the types of testing shown in the Testing
Requirements section (Requirements Testing, Functional Testing,
Performance Testing, Security Testing, User Acceptance Testing,
Operational Readiness Testing), you can complete the following fields:

Field Name
(*Required)

Description

Requirements
Detail

In this field, type text that provides an overview of testing
requirements or goals for this type of testing.

Attachment

Click Add in this field to browse for and select a file that
provides more detail about the requirements for this type
of testing.

URL Reference

Click Edit to the right of this field to specify a URL for a
Web site that provides details about the requirements for
this type of testing.
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7. Click Submit.

The Project Overview page opens.

B Project Audit Trail B Export to PDF

Project: Regression Suite Oeareen

Praject Settings| Configure Participants|

Project Status: Pending Assignment Phase: Project

Project Manager: Admin User

Project Plan Period: July 2008 te September 2009 Project Region: Enterprise

Status: Jul 2, 2008 | Cost
Ol reen ssues os

Override Health O

Project Summary Project Details References

Work Plan

Create work plan from "CMAC - Sample Test Plan’ template

sork plan

lan from a template...

Create work plan from another project..

Staffing
Staffing Profile Status

A Staffing Profile has not been created for this project.

Create a Staffing Profile

Project Cost
Financial Summary (Amounts shown are for the Project Plan Period: July 2008 to September 2009)
Total Forecast: 50.00

Forecast To End Of Current Month: 50.00 Actual Total: 50.00

CMQC - Key Performance Indicators

No results found.

CMQC - Quality Status Trending

No results found.

Project Overview Page

After you initiate a new testing project, a new Project Overview page opens.
From here, you can (with the required permissions) configure project
participants and settings, add portlets to the page, create a work plan, staffing
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profile, and budget for the project. Project overview portlets help you track
project progress.

Project Overview Portlets

Portlets on of the Project Overview page let you track metrics specific to the
application quality effort and outcomes. Figure 5-1 shows the Project
Overview page for an active QA testing project. Table 5-1 lists the Project
Overview portlets available for CMQC testing and application projects.

Project Overview portlets can display project performance data, including
project percent complete, trends in project quality, exceptions, milestone data,
and much more information vital to effective project management.
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Figure 5-1. Project Overview page

¥ Project Audit Trail B Export to PDF

Project: CMQC 2.0 - Testing Project O creen

e ‘ - ‘ e
Project Status: In Teating Phase: Project
Project Manager:  Admin Ussr
Project Plan Period: January 2008 to March 2008 Project Region: Enterprise
Status: Mar 12, 2008
Ocreen Schedule Issues Cost
Override Health D
Project Summary Project Details References
Work Plan Milestone Summary
Hame | pe| January 2008 | February 2008 | Marc Milestone Sched Finish _ Actual Finish _ Owners
[T 7T T T T T T 110 ¥ Test Plan Defined Jan2,2008  Jan2, 2008
CMQC2.0-.. — Test Environment Jan 2, 2008
- Ready
Define Test... [=
Design Test Test Scenarios Jan 2, 2008
== — Ready
st Flan D + Tests Completsd Janz, 2008
Setup Test —
Edit Work Plan_ | e | Program Associations
Program Name Program Manager
Staffing Ravis Program Melizsa Paglia, Jason Waugh, Ravi
Initiative: Annamaneni
Staffing Profile Status
CMQC 2.0 - Testing Project Project Staffing In Planning
 saseline |
Project Cost
Budget: CMQC 2.0 - Testing Project Project Budget
Total Budget: $0.00
Budget to Date: $0.00 Actual To Date: 30.00
Cost Details View Current Budget |
CMQC - Key Performance Indicators 7
Type KPl Name Status | Goal Baseline | Last % Details
A Result  Improvement
Qualty Autemated testing [=] 90% 40% 40% ] We'd like to automate most of our tests and

make it easy to do regresssion testing.

CMQC - Quality Status Trending

Req Created TSR Requirements Requirements Total Priority Open Overall Requirements | Test Defect
#4  On Name | Coverage (%) | Passed (%) Defects | Defects | Defects | Quality | Status Execution | Status
(%) (%) Status
0181 111808 58 1.08 41 21.98 80.48 [=] [m] [=] a
0182 118008 8 1.08 82 2188 80.48 ] ] =] =]
30183 1/20/08 58 1.08 188 21.69 80.72 | ] m] =] ||
30214 112108 £ 108 23 272 §0.73 =] m] =] =]
20215 112208 8 1.08 3 1.21 46.83 =] ] =] =]

Showing 1to 5 of 7 Prev| [NexE| Maximize

CMQC - Project Status

Preferences:

ID#A Date Overall Schedule Scope Resource Issues Risks  Overall Status
Project Status Status  Status Status Status  Comments
Status

30185 1022108 a m] m] o m] m] Test cases have been

developed and QA
engineers are actively
running QA cycles.

HP Cenfer Management for Quality Center QA Testing Projects




56

Table 5-1. Project Overview portlets (page 1 of 2)

Portlet Name

Description

CMQC - Key
Performance Indicators

Shows current status of user-defined KPls for both
project and quality metrics.

CMQC - Quality Status
Trending

Shows overview of all test status reports related to the
project.

CMQC - Project Status

Displays the status of the project based on all
dimensions.

EV Summary

Displays work plan-level earned value metrics for the
project.

Issues

Displays issues logged against the project and
includes links to log issues and view all issues.

Program Associations

Lists the programs with which the project is associated
(if at least one program association exists).

Project Associations

Lists programs associated with the project. This portlet
is print-only and cannot be displayed.

Project Details

Presents information from the Project Details tab. This
portlet is print-only and cannot be displayed.

Project Exceptions

Displays details of project exceptions, including the
violation, task state, start and finish dates, and the
assigned resource.

Milestone Summary

Displays a chronological list of all project milestones,
along with their scheduled start dates, actual finish
dates, and owners.

Project Cost

Provides details on the budget and work plan costs
associated with the project.

Project Participants

Lists participants associated with the project. This
portlet is print-only and cannot be displayed.

Project References

Displays the references that are attached to the project
based on reference types, relationship, time period
when they were added, and whether or not they are
preventing actions on tasks.
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Table 5-1. Project Overview portlets (page 2 of 2)

Portlet Name Description

Provides a quick status for the selected project or
subproject, including information on the project status,

Project Summary and project health, percent complete, project manager, and

Health start and finish dates. This portlet is print-only and
cannot be displayed.
Risks Lists the risks associated with the project and displays

a link to view all risks.

Lists project scope changes and displays a link to a

Scope Changes view of all scope changes.

Displays the staffing profile associated with the project,
Staffing plus any staffing profile baselines that have been
created.

Displays the staffing profile associated with the project
Time Approval and any staffing profile baselines that have been
created.

Displays summary tasks, tasks and milestones for the
Work Plan project in Gantt chart format, and includes drill-down to
task details.

A few Project Overview portlets cannot be displayed, but can only be printed.
These hidden portlets contain information (such as the project name and
project manager) from the project header and the project request that is not
available in the visible portlets. You can select the print-only portlets when you
export a Project Overview page to PDF for printing.

Print-only portlets are visible in the Layout section of the Project Overview
Layout page, where they are indicated with a grey background.

The position of the print-only portlets within the layout configuration page has no

) impact on the project summary. The project manager can remove them, although this
is not recommended. A user printing the Project Overview page can also exclude
these portlets from the exported PDF file.
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Exporting the Project Overview Page as a PDF File

You can export the Project Overview page for a project as a PDF file for
viewing or printing.

To export the Project Overview page as a PDF file:

1. In PPM Center, search for, and then open the project of interest.

) For information on how to search for and open projects in PPM Center, see the
HP Project Management User’s Guide.

2. At the top of the Project Overview page, select the Export to PDF link.

B Project Audit Trail 8 Export to POF

Project: Auto Suite 30B O creen

Project Settings | Configure Participants
Project Status: Pending A=ssignment Phase: Project
Project Manager:  Admin Uzer

Project Plan Period: May 2008 to August 2009 Project Region: Enterprize
: Enterprize
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-3 PDF Settings - Microsoft Internet Explorer provided by Hewlett-.... :

ﬂﬂ Close Window X

PDF Settings

Configure Dashboard PDF-Export settings.

Display
Display header

Display timestamp

Display title |HE‘.‘.‘ Page

Choose Portlets
Comments

Paper

Page Type: | Letter (& 1/2 x 11 in) w |

Orientation: (@) Portrait
(O Landscape

Scale: (O Fit to page

@ Fit to page width (add page breaks when needed)

() Seale by %
Margins: Unit:

Top: Left
Bottom: Right:

Open PDF document In browser window

|:| Leave settings window open

3. To specify which portlets to include in the exported page:
a. Expand the Choose Portlets section.

b. To exclude a portlet from the exported PDF file, deselect the
corresponding checkbox.

4. Configure the remaining PDF page settings, and then click Export.

The new PDF file opens in a new browser window.
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60

Every project type has associated policies, which are formalized business rules
that govern various aspects of a project. The project type and its policies
determine a project’s settings. You can edit policy setting from the Project
Settings page.

To view the Project Settings page:
1. Log on to PPM Center.

2. From the menu bar, select Open > Project Management Project & Tasks >
Search Projects.

The Search Projects page opens.

3. Complete one or more fields to specify your project search criteria, and
then click Search.

The projects that match your search criteria are listed.
4. In the Project Name column, click the name of the project to view.

The Project Overview page opens.
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5. Click Project Settings.

Project Settings - Regression Suite

] o] el

* Project Type: CIQC - QA Testing Project Type

Description: CMQC QA Testing Project Project type

Select a policy to configure

Project Fields

Project Fields Some fields must be used by Project Management and are always enabled
Work Plan Schedule Fields
led will b available for entry and viewing in the work plan. The Scheduled Effort field is
led by the Cost and Effort policy

Request Types a

« Scheduled Start
Schaduling v Scheduled Finizh

w Scheduled Duration
Schedule Health Scheduled Effort (controlled by the Cost and Effort policy’
Cost and Effort Actuals Fields

Actuals fields track the progress of the work plan execution. Fields e led here will be available for

Cost and Earned Value entry and ing in the work plan. Effort fields are enabled o led & Cost and Effort policy
Health

v % Complete
v Actual Start

Microsoft Project N
Actual Finish

Integration

Actual Duration (always system-calculated

Staffing Profile

Actual Effort (controlk
Assignments

Estimated Remaining Effort (controlled ost and Effort policy
Project Health [] Estimated Finish Date
Issue Health Additional Fields

Activity (used to cate

Capitalization
Task Auditing
Role (used to categor

for Work Load and Project Staffing

Project Overview o Dien!
Layout Milestone Display

ou can control which milesto
Milestones are identifie

tile on the Project Overview page

are visible

in the: Wik
in the Edit

jor |

Project Security

N [] Display Major Milestones only
& Kev: Folicies are

from Project
d cannot be

save | vone| _cance |
You can configure the following project policies from the Project Settings
page:

e Project Fields. The Project Fields policy controls the fields tracked by a
work plan. Selecting the checkbox or option next to a field activates it.
Some fields contained in the Project Fields policy are required in order for
you to take full advantage of HP Project Management functionality, and
should be left active.
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e Work Plan. The Work Plan policy allows you to specify whether a project

will have a work plan, as well as suggest or enforce a specific work plan
template to be used with the project type.

The Work Plan policy lets you specify whether a project will have a work
plan, as well as suggest or enforce a specific work plan template to be used
with the project type. This policy’s override behavior is as follows:

o Ifyou specify a work plan template in the Work Plan Template field and
specify that the policy cannot be overridden, a project created from this
project type can only create a work plan based on this work plan
template. Moreover, the default work plan template cannot be changed.

o Ifyou specify a work plan template in the Work Plan Template field and
specify that the policy can be overridden, the manager for a project of
this type can choose to create the work plan from the default template,
another template, or from scratch.

o Ifyou do not specify a work plan template, the policy can be
overridden by default. This is appropriate for project types that do not
require a work plan template.

Request Types. The Request Types policy specifies the request type that:

o Controls the fields displayed on the Project Details tab on the Project
Overview page. This request type is also associated with the workflow
that drives the project process.

o Represents the project in your portfolio (if you have installed HP
Portfolio Management).

o Isused to report and resolve project issues, report and resolve project
risks, and report and resolve project scope changes.

Scheduling. The Scheduling policy specifies options that govern how the
work plan is scheduled.

Schedule Health. The Schedule Health policy controls the project’s
schedule health indicator, and determined the active exception rules for a
project.
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e Cost and Effort. The Cost and Effort policy determines how the project
costs, effort, and workload are managed, including how this information
flows between project entities such as the work plan, staffing profile,
budget, and time sheets, if any. The policy determines whether financial
information is tracked for the project, how actuals are captured, and how
costs are calculated. If you have installed HP Time Management to capture
actuals, this policy controls the Time Management settings for a project
type. If you do not have HP Time Management installed or choose not to
use it, you can select and configure HP Financial Management options.

e Cost and Earned Value Health. The Cost and Earned Value Health
policy determines whether the cost health for a project is tracked, and if it
is, which metrics will be evaluated to determined project health. It is used
to indicate the health of a project in terms of its cost.

e Microsoft Project Integration. If you integrate HP Project Management
and Microsoft Project, you can:

o Open a Microsoft Project file in HP Project Management
o Send an HP Project Management work plan to Microsoft Project

o Use Microsoft Project to maintain the work plan as actuals are
collected through HP Project Management

o Map HP Project Management user data and Microsoft Project custom
data

The Microsoft Project Integration policy controls the level of integration
between HP Project Management and Microsoft Project.

e Staffing Profile Assignments. HP Resource Management allows you to
attach a staffing profile to a project to track resource demand and usage.
The Staffing Profile Assignments policy lets you specify a default resource
pool to which all resource requests for the staffing profile will be routed.
For more information on staffing profiles, see the HP Resource
Management User’s Guide.
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e Project Health. The project summary condition indicator displayed on the
Project Overview page next to the project name reflects the project’s
overall health as a weighted average of the health indicators for
Scheduling, Cost and Earned Value Health, and Issue Health. The Project
Health policy determines the relative weights of these indicators. (By
default, each indicator is weighted equally.) The Project Health policy also
controls whether project managers can override the project’s calculated
health.

e Issue Health. As a project progresses through its workflow, any number of
issues may come up that must be submitted and resolved using the project
issue request. The issue health indicator (a colored icon similar to the
indicators for Scheduling and Cost and Earned Value Health) reflects the
real-time project status in terms of the issues submitted against it.

The Issue Health policy determines whether issue health is tracked for a
project, and also controls the factors that affect issue health indicator
calculation.

e Task Auditing. HP Project Management can maintain an audit trail of
changes to task fields as well as a history of task status, which is always
recorded. The Task Auditing policy controls which fields are recorded.

) To maintain a transaction history for a field, you must first enable the field through
the Project Fields policy.

e Project Overview Layout. The Project Overview Layout policy controls
the many settings used to print and display portlets for a project.

e Project Security. The Project Security policy determines whether a
summary task owner can edit the summary tasks assigned to them, as well
as the users who can view the project and its cost data.

For more detailed information on project policies and instructions on how to
configure each of them, see the HP Project Management User’s Guide.
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Configuring Project Participants

In HP Project Management, project participants belong to one or more of the
following groups:

Project managers. Project managers take part in project planning and
management, and oversee project execution, issue resolution, and budget
management.

Stakeholders. Stakeholders are users who do not work on a project, but are
interested in and need to be updated on project status and progress.

Resources. Resources are project team members who work on project
tasks, but do not have the administrative responsibilities of a project
manager.

Summary Task Owners. Summary task owners are the people named on
summary tasks who have oversight over associated sections of the work
plan.

Program managers. Program managers are responsible for managing a
collection of projects and their associated scope changes, risks, issues, and
resource requests.

You can add participants to a new application project from the Configure
Project Participants page, which is shown in Figure 5-2.

Figure 5-2. Configure Project Participants page

Configure Project Participants - Regression Suite Save | Done| Cancel
w are all of the groups that have a relationship to this project
Project Managers Resources
Name Type Thiz group has no members.
M Admin User User _
Summary Task Owners
MI This group has no members
Stakeholders Program Managers
Name Type This group has no members.
Add Stakeholder... ¥
Save | Done | Cancel

To open this page from the Project Overview page, click Configure
Participants. For detailed instructions on how to add project participants, see
the HP Project Management User’s Guide.
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CMQC - Testing Project Workflow

The testing projects that you create follow the CMQC - Testing Project
workflow, the graphical layout of which is shown in Figure 5-3 on page 67.

The CMQC - Testing Project workflow is the default workflow attached to new CMQC-

) testing projects. You can create a different workflow and assign it to a project. For
information on how to create a workflow, see the HP Demand Management
Configuration Guide.

The CMQC - Testing Project workflow includes the following steps:
1. Create a test plan.
2. Set up the testing environment.
3. Specify test plan details and determine required testing assets.
4. Run tests.
5. Generate test status reports.

6. Submit a final QA report detailing test results and application quality
status.

Table 5-2 on page 68, Table 5-3 on page 69, and Table 5-4 on page 70 list
descriptions of the steps in all three phases of the CMQC - QA Testing Project
workflow.

The actual testing activities (defining test requirements, recording test scripts,
running tests, and so on) are performed in Quality Center. The QA testing
project within the CMQC provides an overriding structure and best practices
for governing the testing effort within the application lifecycle.
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Figure 5-3. CMQC - QA Testing Project workflow
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A QA testing project begins with the submission of a request form that details
the requirements for the application quality effort, including project scope,
testing requirements, and test plan details. As the request passes through the
workflow, it is assigned to the QA manager, who is responsible for overseeing
the project’s progress and reporting on its status.

Through a link to the QC project, a QA testing project can receive automatic
updates on the test status. To take advantage of this feature, HP recommends
that you establish a connection between two such projects.

The QA manager can link a QA testing project to an existing QC project, or
create a new QC project, in which case he must submit a Quality Center
Administrative Request. (For additional information on QC Administrative
requests, see Chapter 10, Managing Quality Center of Excellence
Administrative Activity, on page 165).

The QA lead must verify that the specified Quality Center project is valid, and
that the requirement ID provided corresponds to the parent requirement for the
entire testing effort. This requirement ID is used to report on coverage and test
results. The details of this phase of the testing project workflow are described
in Table 5-2.

Table 5-2. CMQC - QA Testing Project workflow - Phase 1 (page 1 of 2)

Workflow Step Description
1. New A new testing project request is submitted.
2. Assign QA Lead The request is assigned to a QA manager.

If a new QC project is required, the QA
manager may choose to submit a new QC
administrative request to automate its creation.
Alternatively, the QA Testing Project request
may be assigned to an existing QC project.

Set Up Quality Center
Profile

The QA manager creates a QC administrative
request and attaches it as a reference to the QA
testing project request. This administrative
request is a child of the QA testing project
request. The administrative request is used to
create a new QC project, which is then linked to
this testing initiative.

Create Project
Administrative Request
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Table 5-2. CMQC - QA Testing Project workflow - Phase 1 (page 2 of 2)

Workflow Step Description

Information provided for the QC instance is

5. Verify Project In QC verified.

This step checks to determine whether the
specified requirement path exists in the
particular QC project. If the path does not exist,
it is generated.

e If a new requirement path is specified, it is
created in the QC project, and a new QC
requirement ID is assigned.

e [f arequirement ID is set, the path
corresponding to the requirement ID is
displayed in the requirement field.

6. Create Requirement

This automated check determines whether the
8. Passthru requirement path and ID settings were
completed.

The QA lead verifies the QC project and

7. Validate QC Settings : .
requirements settings.

This automated check determines whether the
9. Passthru field(s) required to validate the QC settings
were completed.

During Phase 2, the assigned QA manager either creates a work plan for the
QA testing project based on a work plan template, or associates an existing
PPM Center work plan as a reference to this QA testing project request. Phase
2 workflow steps are described in Table 5-3.

Table 5-3. CMQC - QA Testing Project workflow - Phase 2 (page 1 of 2)

Workflow Step Description
10 Verify Test Work Plan The QA manager verifies that a test work plan
" | Exists exists.

The QA manager selects a work plan template
11. | Select Work Plan Type on which to base a new work plan for the QA
testing project.
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Table 5-3. CMQC - QA Testing Project workflow - Phase 2 (page 2 of 2)

Workflow Step Description

Create Work Plan From The QA manager creates a work plan based on
12.

Template the selected work plan template.

This step retrieves the default work plan
template from the project type, which can be
used as the basis to create a work plan at a
later workflow step.

13 | Default Work Plan Temp

If either step 9 or step 11 was successful, the
14. | OR
request moves to the next step.

During Phase 3 of the workflow, the QA manager designs a testing plan, sets
up the test lab environment, and then monitors the workflow steps to ensure a
comprehensive and consistent testing effort. HP recommends that the QA
manager create and distribute periodic test status reports to identify trends and
provide visibility into the testing project.

CMQC provides the ability to automatically query the QC project and gather
data on application quality and progress of the testing effort. For details on test
status report requests, see Chapter 9, QA Test Status Reports, on page 153.
Before a QA testing project can be closed, the QA lead submits a final
application quality status report to project management and other stakeholders.
Quality KPIs are a key factor in determining whether the application is ready
for deployment. The details of Phase 3 of the testing project workflow are
described in Table 5-4.

Table 5-4. CMQC - QA Testing Project workflow - Phase 3 (page 1 of 2)

Workflow Step Description

The QA lead designs a test plan for the

15. | Design Test Plan ;
project.

The QA lead sets up the testing

16. | Set up Test Environment environment for the application under test.

The QA lead develops test scripts and any

17. | Develop Detailed Test Plan related assets for the testing effort.
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Table 5-4. CMQC - QA Testing Project workflow - Phase 3 (page 2 of 2)

Workflow Step

Description

18.

Execute Test Plan

This step is used to indicate the start of
application testing. The QA lead may
choose to automate the creation of test
status reports that retrieve progress data on
test coverage and defect status.

19.

Create Testing Status Report

The test status report request is
automatically generated and attached as a
reference.

20.

Submit QA Report

The QA lead submits a report to project
management and application development
stakeholders. The results in the KPI table
can be uploaded to the linked application
project's KPI table to update the project
management team on the status of the QA
effort.

21.

Update Application Project
Status?

Updates the status fields (overall quality,
requirements coverage and review status,
test execution results, and defect statistics)
in the application project, which is a parent
of this QA testing project request. A test
status report request must be created for
this testing project to upload data on
requirements, test execution, and defects.

22.

Update Project Quality Status

This step updates the quality status
information in associated application project
(if any).

23.

Test Cycle Completed

This step closes the QA testing project
request.

For detailed information on how to work with workflows, see the HP Demand
Management Configuration Guide or the HP Deployment Management
Configuration Guide.
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Creating and Managing Work Plans

Once you have created a project, you can create its work plan. A work plan is a
vital tool that organizes specific project tasks and deliverables into a
hierarchical structure that makes project work easier to prioritize and track. It
covers the all project requirements and the steps required to meet them. It helps
keep a project team aware of what they need to do and when they need to do it.

Project managers oversee work plans to ensure they accurately reflect current
project status through all phases of the project lifecycle. With a well-managed
work plan, a project team always knows what work has been completed, and
what work remains to be done.

The work plan contains the work breakdown structure of the application or
testing project, which defines such project elements as:

e Task hierarchy

e Resources or skills assigned to tasks

e Task and project schedule

e Project exception monitoring

e Project milestones

e Baselines

e Project budget

e Expected cost and effort

e Import a work plan from Microsoft Project

e Build a work plan from scratch
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Work-Plan Templates

Work plan templates are used in HP Project Management to create repeatable
processes to be used as a model and basis for new projects. These templates
speed up work-plan setup.

A work plan template consists of a reusable set of tasks that you can use to
create a work plan and at the same time preserve any notifications, resource
assignments, and predecessors. For example, a company with several different
software product projects might use the same workflow for all development
efforts. Instead of creating a separate work plan from scratch for each new
project, the company can use a work plan template to quickly create the work
plans. A project manager can modify information for an individual project, as
needed.

The default workflows for CMQC projects require that you associate a work
plan with the project. You do this from HP Project Management.

PPM Center provides two out-of-the-box work plan templates for CMQC
projects. The CMQC - Sample SDLC Plan is designed for creating work plans
for CMQC - application projects, and the CMQC - Sample Test Plan template
is designed for creating work plans for CMQC QA testing projects.

If the CMQC - Sample Test Plan template does not suite your needs for all of
your QA testing project work plans, you can revise it and save it as a new
template, or create a template from scratch to better address your project needs.

To view the CMQC - Sample Test Plan template:
1. Log on to PPM Center.

2. From the menu bar, select Open > Administration > Project Types and
Templates > Manage Work Plan Templates.

The Manage Work Plan Templates page opens.

Manage Work Plan Templates

@ Export to Excel

Select a Template

Enabled Template Owner

D
Admin User A re development lifecycle plan

Admin User stplan for testing projects

Create Work Plan Template
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3. In the Template Name column, click CMQC - Sample Test Plan.

CMQC - Sample Test Plan

‘Template Hame: |CMC!C - Sample Test Plan ‘
Enabled: ®ves Ono
Description: |r\ sample test plan for testing projects ‘
Configure Access Edit Work Plan Template | copy| Delete | Save | Done | Cancel

4. Click Edit Work Plan Template.

The Work Plan Template page opens.

Work Plan Template: CMQC - Sample Test Plan

=

Expand to: [ewelw| | +=| 2=|| || 4| X|| | B B EE Editv | _Actions™ Total Tasks: 17
Scheduled Scheduled
Seq | Name Duration Effort (hrs) Predecessors Resources | Role

0| = cmac - sample Test Plan 125.00 1,000.00
1 Define Test Regirements 10.00 80.00
2 Design Test Plan 20.00 160.00
3 # TestPlan Defined 0.00 0.00

=l setup Test Environment 20.00 180.00

Provisien/Allocate Hardware 10.00 80.00

[} Setup Application Under Test 10.00 £0.00
7 # TestEnvirenment Ready 0.00 0.00
g =l Develop Tests Scenarios 55.00 440.00
] Generate/Update Test Data 15.00 12000
10 DevelopiUpdate Manual Tests 10.00 £0.00
" p/Update Automation Tests 30.00 240.00
12 # Test Zcenarics Ready 0.00 0.00
13 Exer st Plan 15.00 12000
14 ompleted 0.00 0.00
15 Quality 2.00 16.00
18 Submit Final Report 3.00 2400

Seq#

Activity

For instructions on how to create and edit work plans and work plan templates,
see the HP Project Management User’s Guide.
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6 HP Center Management for Quality Center
Application Projects

Overview of CMQC Application Projects

Application delivery is a complex process that involves development, testing,
and fine tuning before production deployment. To ensure successful business
outcomes, application quality must be approached as a consistent process that
is part of the overall application delivery lifecycle.

The IT projects you create and manage in PPM Center provide visibility into
IT tasks and promote collaboration between IT and the LOB. This enables
businesses to consolidate, prioritize, and fulfill demand for both strategic
projects and day-to-day activities, and also manage service levels. CMQC
extends this PPM Center functionality to include quality steps in the
application delivery project processes and workflows.

By linking the HP Quality Center and PPM Center projects and extending the
workflow to include the essential testing steps, CMQC helps keep applications
aligned with business objectives and provides the entire organization with
visibility into quality effort’s resources, progress, and metrics. The project
manager manages the application project, while the QA lead, development
lead, and operations lead ensure that the key phases of the development
lifecycle are successfully completed.

This chapter contains instructions on how to create CMQC application
projects. It also provides high-level information about project work plans, and
details about the workflow and workflow steps that define an application
project’s lifecycle.

) To meet the requirements of your organization, you can create projects types. For
instructions, see the PPM Center HP Project Management Configuration Guide.
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Creating a CMQC - Application Project

To create an application project:

1. Log on to PPM Center.

2. From the menu bar, select Open > Center Management > Quality
Management > Initiate Testing Project.

The Create New Project page opens.

Create New Project

“Project Hame:

“Project Type:

Project Manager: Admin User

*Planned Start Period:

*Planned End Period:

“Region: Enterprise

i [

i [

Create

3. Complete the following fields:

Field Name
(*Required)

Description

*Project Name

Type a name for the project in this field.

*Project Type

From the auto-complete list, select CMQC -
Application Project Type.

*Project Manager

From the auto-complete list, assign a resource other
than the default (your name) as project manager.

*Planned Start
Period

From the auto-complete list, select the calendar
period (month and year) during which you expect the
project to start.

*Planned End
Period

From the auto-complete list, select the calendar
period (month and year) during which you expect the
project to end.

*Region

From the auto-complete list, specify a region (other
than the default) to associate with the project.

4. Click Create.
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Create New CMQC - Application Project

The Create New CMQC - Application Project page opens.

Expand A1l Collapse Alf

= Header

E Instructions

* Use this form to provide all the information related to a Project.
® The fields with * require your input,

Hot Submitied

H Summary

Status
Created By: Admin User “Priority:
Driving Process: CHaC - Application Project
“Business Unit:
“Description: [

s

Project Dependencies
= Project Details

Project Information

Project Hame Financial Tracking EU Business Objective: =

“Project Class . n

“Application: ] “Version:
Project OwnersiLeads

Project Manager: ] Project Sponsor:

Development Lead: ] QA Lead:

Operations Lead: [

Project Health

L =
[

Project Health: Project Financial Tracking EU

Project Planning

Planned Start Period: Iay 2009 Planned Finish Period: April2010

=l Business Case Details

Staffing Profile: (No Staffing Profie!

Return on Investment:

Value Rating: 0 RiskRating:
Score Adjustment: 1 Total Score:
Business Case Doc: {no document atiached)
Requirements Doc: {no document attached)
Financial Summary: (o Financial Summary)

B Value Ratings

Internal Rate of Return [

strategic Matoh: [

Competitive Advantage [

Competitive Response: [

Productivity: [

® Risk Ratings

11

# Details

& Notes
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) To view descriptions of the fields in each section of this page, click the Help with
CMQC - Application Project link at the top left of the page.

5. Complete the following fields in the Summary section:

F’iﬁfqm?é?ﬁ Description

To change the project priority to a value other than

Priority Normal, select a value from this list.

From this list, select the business unit on behalf of which

*Business Unit . .
you are creating the project.

*Description Type a short description of the project.

From the auto-complete list or the resource selector,
Assigned To specify a resource to be responsible for completing or
managing the application project request.

6. Complete the following fields in the Project Details section:

Field Name -

(*Required) Description

Project Information

Business From the auto-complete list, specify a business objective
Objective for the project.

From the auto-complete list, select the project class

Project Class (such as growth, innovation, core, and so on).

From the auto-complete list, specify the class of asset
*Asset Class the project produces (such as informational,
infrastructure, transaction, and so on).

*Application Type the product or application name in this field.
*Version Type the product or application version in this field.
Project Owners/Leads

From the list, select the name of the resource to act as
Project Manager | the project manager responsible for the application
project request.
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Field Name
(*Required)

Description

Project Sponsor

From the list, select the name of the project sponsor
supporting the application or project initiative.

Development
Lead

From the list, select the name of the resource to be
responsible for overseeing project development.

From the list, select the name of the QA manager or lead

Sl responsible for the project testing effort.
Operations From the list, select the name of the operations lead
Lead responsible for application deployment.

Project Planning

Work Plan
Template

From the auto-complete list, select an existing PPM
Center work plan. This value must match the project
name, or the name of an existing PPM Center project.

7. Click Submit.

The Project Overview page opens.
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1 Project Audt Trail B Export to PDF

Project: Financial Tracking EU Ocreen

Project Settings| Configure Participants |

Delete Project
Project Status: Pending Assignment Phase: Project
Project Manager: Admin User
Project Plan Period: May 2003 to April 2010 Project Region: Enterprise
Status: Jul 2, 2008 | Cost
ssues os
Green

Override Health D

Project Summary Project Details. References

Waork Plan

Create v

<plan from 'CMQC - Sample SOLC Plan' template

Staffing

Staffing Profile Status
A Staffing Profile has not been created for this project.

Create a Staffing Profila

Project Cost

Financial Summary (Amounts shown are for the Project Plan Period: May 2009 to April 2010)
Total Forecast: $0.00

Forecast To End Of Current Month: 30.00 Actual Total: 50.00

CMQC - Quality Status Trending

No resufts found

CMQC - Key Performance Indicators

No resufts found
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Project Overview Page

After you initiate a new application project, a new Project Overview page
opens. From here, you can (with the required permissions) configure project
participants and settings, add portlets to the page, create a work plan, staffing
profile, and budget for the project. The Project Overview portlets help you
track project progress.

Project Overview Portlets

Portlets on the Project Overview page let you track metrics specific to the
application quality effort and outcomes. Figure 6-1 shows the Project
Overview page for an active CMQC application project. Table 6-1 lists the
Project Overview portlets available for CMQC application projects and QA
testing projects.

Project Overview portlets can display project performance data, including
project percent complete, trends in project quality, exceptions, milestone data,
and much more information vital to effective project management.
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Figure 6-1. Project Overview page

¥ Project Audit Trail 8 Export to PDF

Project: WB3 - Application Project O creen

Projectsetings | __ Confgu partiipents |

Project Status:
Project Manager:
Project Plan Period: November 2007 fo August 2008

Check Test Completion Status

Admin User

Status: Jan 15, 2008

Phase: Project

Project Region: Enterprise

Schedule lssues Cost
O creen
Project Summary Project Details References
Work Plan Milestone Summary
Hame |drovo7r [Deco7 |Janoe  |Febos | Mar Milestone SchedFinish  Actual Finish  Owners
|| | ‘ | ‘ | | ‘ | ‘ | | | | | ‘ | ‘ There are no milestones
WB3 - Appli... —
Reguirements ==
Design —
Buid =
=t i—
Edit WorkPlan | View Baselines |
Staffing
Staffing Profile Status
A Staffing Profile has not been created for this project.
Create a Staffing Profile
Project Cost
Create a Budget
CMQC - Quality Status Trending
Req Created | TSR Requirements Requirements  Total Priority Open Overall Requirements | Test Defect
#A On Name Coverage (%) Passed (%) Defects | Defects | Defects Quality  Status Execution | Status
(%) (%) Status
30030 1212007 WB3- 59 11 72 25 7778 [m] [m] [=] |
Application
Project
30031 W83 - g 11 72 25 7778 o o | [m]
Application
Project
30032 1212007 WB3- &0 1.1 72 el 7778 o o [ } o
Application
Project
30033 121307 WB3- &0 1.1 7z 25 7778 = =] E =]
Application
Project
Showing 1 to 4 of 4 Prev| Next| Maximize
CMQAC - Key Performance Indicators
Mo results found
CMQC - Project Status
Preferences:
ID#A Date Overall Schedule Scope Resource Issues Risks Overall Status Comments
Project Status Status  Status Status Status
Status
30009 1211807 || =] =] [m] L] a
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Table 6-1. Project Overview portlets (page 1 of 2)

Portlet Name

Description

CMQC - Key
Performance Indicators

Shows current status of user-defined KPls for both
project and quality metrics.

CMQC - Quality Status
Trending

Shows overview of all test status reports related to the
project.

CMQC - Project Status

Displays the status of the project based on all
dimensions.

EV Summary

Displays work plan-level earned value metrics for the
project.

Issues

Displays issues logged against the project and
includes links to log issues and view all issues.

Program Associations

Lists the programs with which the project is associated
(if at least one program association exists).

Project Associations

Lists programs associated with the project. This portlet
is print-only and cannot be displayed.

Project Details

Presents information from the Project Details tab. This
portlet is print-only and cannot be displayed.

Project Exceptions

Displays details of project exceptions, including the
violation, task state, start and finish dates, and the
assigned resource.

Milestone Summary

Displays a chronological list of all project milestones,
along with their scheduled start dates, actual finish
dates, and owners.

Project Cost

Provides details on the budget and work plan costs
associated with the project.

Project Participants

Lists participants associated with the project. This
portlet is print-only and cannot be displayed.

Project References

Displays the references that are attached to the project
based on reference types, relationship, time period
when they were added, and whether or not they are
preventing actions on tasks.
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Table 6-1. Project Overview portlets (page 2 of 2)

Portlet Name Description

Provides a quick status for the selected project or
subproject, including information on the project status,

Project Summary and project health, percent complete, project manager, and

Health start and finish dates. This portlet is print-only and
cannot be displayed.
Risks Lists the risks associated with the project and displays

a link to view all risks.

Lists project scope changes and displays a link to a

Scope Changes view of all scope changes.

Displays the staffing profile associated with the project,
Staffing plus any staffing profile baselines that have been
created.

Displays the staffing profile associated with the project
Time Approval and any staffing profile baselines that have been
created.

Displays summary tasks, tasks and milestones for the
Work Plan project in Gantt chart format, and includes drill-down to
task details.

A few Project Overview portlets cannot be displayed, but can only be printed.
These hidden portlets contain information (such as the project name and
project manager) from the project header and the project request that is not
available in the visible portlets. You can select the print-only portlets when you
export a Project Overview page to PDF for printing.

Print-only portlets are visible in the Layout section of the Project Overview
Layout page. They are indicated with specialized styles, such as a grey
background color.

The position of the print-only portlets within the layout configuration page has no
impact on the project summary. The project manager can remove them, although this
is not recommended. A user printing the Project Overview page can also exclude
these portlets from the exported PDF file.
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Exporting the Project Overview Page as a PDF File

You can export the Project Overview page for a project as a PDF file for
viewing or printing.

To export the Project Overview page as a PDF file:

1. In PPM Center, search for, and then open the project of interest.

) For information on how to search for and open projects in PPM Center, see the
HP Project Management User’s Guide.

2. At the top of the Project Overview page, select the Export to PDF link.

B Project Audit Trail 8 Export to POF

Project: Auto Suite 30B O creen

Project Settings | Configure Participants

Project Status: Pending A=ssignment Phase: Project
Project Manager:  Admin Uzer

Project Plan Period: May 2008 to August 2009 Project Region: Enterprize
: Enterprize
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The PDF Settings window opens.

) PDF Settings - Microsoft Internet Explorer provided by Hewlett-... [

Eia Close Window X

PDF Settings

Configure Dashboard PDF-Export settings.

Display
Display header

Display timestamp

Display title |Mew Page

Choose Portlets

Comments

Paper

Page Type: | Letter (8 1/2x 11 in} ¥ |

Orientation: (%) Portrait
() Landscape

Scale: (O Fitto page

@ Fit to page width (add page breaks when needed)
(O Scale by %

Margins: Unit:
Top: Left:
Bottom: Right:

Open PDF document In browser window

|:| Leave settings window open

[upnrt|c:anc=||

Close Window X

3. Configure the PDF page settings, and then click Export.

The PDF file opens in a new browser window.
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Configuring Project Settings

Every project type has associated policies, which are formalized business rules
that govern various aspects of a project. The project type and its policies
determine a project’s settings. You can edit policy setting from the Project

Settings page.

To view the Project Settings page:

e From the Project Overview page, click Project Settings.

Project Settings - Financial Tracking EU

e ome] e

* Project Type: CMQC - Application Project Type
Description: CMQC Application Project Type

Select a policy te configure:

Project Fields
Work Plan

Request Types

Scheduling
Schedule Health
Cost and Effort

Cost and Earned Value
Health

Microsoft Project
Integration

Staffing Profile
Assignments

Project Health

Issue Health

Task Auditing

Project Overview Layout

Project Security

Key: Pelicies are inherited
from Pr and
cannot be altersd.

Project Fields
Some fields must be used by Project Management and are always enabled
Schedule Fields

Fields enabled here wil be available for entry and viewing in the work plan. The Scheduled Effert field is
enabled or dizabled by the Cost and Effert policy.

« Scheduled Start
v Scheduled Finish
« Scheduled Duration

Scheduled Effort (controlled by the Cost and Effort policy

Actuals Fields

Actuals
and vie

k plan execution. Fields ena re will be available for entry
g in the work plan. Effort fields are enabled or disabled by and Effort policy

v % Complete
w  Actual Start

v Actual Finigh

stem-calculated

Actual Duration (alwa

Actual Effort (controlied by the Cost and Effort policy

(controlled by th

Estimated Remaining Effort ost and Effort policy

[[] Estimated Finish Date
Additional Fields

Activity (us

Role (used to categori

sks, recommended for Capitalization

ources, recommended for Work Lead and Project Staffing

Milestone Display

3 tile on the Project Overview page. Milestones

|:| Display Major Milestones onty

] ] e
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You can configure the following project policies from the Project Settings
page:

e Project Fields. The Project Fields policy controls the fields tracked by a
work plan. Selecting the checkbox or option next to a field activates it.
Some fields contained in the Project Fields policy are required in order for
you to take full advantage of HP Project Management functionality, and
should be left active.

e Work Plan. The Work Plan policy allows you to specify whether a project
will have a work plan, as well as suggest or enforce a specific work plan
template to be used with the project type.

The Work Plan policy lets you specify whether a project will have a work
plan, as well as suggest or enforce a specific work plan template to be used
with the project type. This policy’s override behavior is as follows:

o Ifyou specify a work plan template in the Work Plan Template field and
specify that the policy cannot be overridden, a project created from this
project type can only create a work plan based on this work plan
template. Moreover, the default work plan template cannot be changed.

o Ifyou specify a work plan template in the Work Plan Template field and
specify that the policy can be overridden, the manager for a project of
this type can choose to create the work plan from the default template,
another template, or from scratch.

o Ifyou do not specify a work plan template, the policy can be
overridden by default. This is appropriate for project types that do not
require a work plan template.

e Request Types. The Request Types policy specifies the request type that:

o Controls the fields displayed on the Project Details tab on the Project
Overview page. This request type is also associated with the workflow
that drives the project process.

o Represents the project in your portfolio (if you have installed HP
Portfolio Management).

o Isused to report and resolve project issues, report and resolve project
risks, and report and resolve project scope changes.
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e Scheduling. The Scheduling policy specifies options that govern how the
work plan is scheduled.

e Schedule Health. The Schedule Health policy controls the project’s
schedule health indicator, and determines the active exception rules for a
project.

e Cost and Effort. The Cost and Effort policy determines how the project
costs, effort, and workload are managed, including how this information
flows between project entities such as the work plan, staffing profile,
budget, and time sheets, if any. The policy determines whether financial
information is tracked for the project, how actuals are captured, and how
costs are calculated. If you have installed HP Time Management to capture
actuals, this policy controls the Time Management settings for a project
type. If you do not have HP Time Management installed or choose not to
use it, you can select and configure HP Financial Management options.

e Cost and Earned Value Health. The Cost and Earned Value Health
policy determines whether the cost health for a project is tracked, and if it
is, which metrics will be evaluated to determined project health. It is used
to indicate the health of a project in terms of its cost.

e Microsoft Project Integration. If you integrate HP Project Management
and Microsoft Project, you can:

o Open a Microsoft Project file in HP Project Management
o Send an HP Project Management work plan to Microsoft Project

o Use Microsoft Project to maintain the work plan as actuals are
collected through HP Project Management

o Map HP Project Management user data and Microsoft Project custom
data

The Microsoft Project Integration policy controls the level of integration
between HP Project Management and Microsoft Project.

e Staffing Profile Assignments. HP Resource Management allows you to
attach a staffing profile to a project to track resource demand and usage.
The Staffing Profile Assignments policy lets you specify a default resource
pool to which all resource requests for the staffing profile will be routed.
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For more information on staffing profiles, see the HP Resource
Management User’s Guide.

Project Health. The project summary condition indicator displayed on the
Project Overview page next to the project name reflects the project’s
overall health as a weighted average of the health indicators for
Scheduling, Cost and Earned Value Health, and Issue Health. The Project
Health policy determines the relative weights of these indicators. (By
default, each indicator is weighted equally.) The Project Health policy also
controls whether project managers can override the project’s calculated
health.

Issue Health. As a project progresses through its workflow, any number of
issues may come up that must be submitted and resolved using the project
issue request. The issue health indicator (a colored icon similar to the
indicators for Scheduling and Cost and Earned Value Health) reflects the
real-time project status in terms of the issues submitted against it.

The Issue Health policy determines whether issue health is tracked for a
project, and also controls the factors that affect issue health indicator
calculation.

Task Auditing. HP Project Management can maintain an audit trail of
changes to task fields as well as a history of task status, which is always
recorded. The Task Auditing policy controls which fields are recorded.

To maintain a transaction history for a field, you must first enable the field through
the Project Fields policy.

Project Overview Layout. The Project Overview Layout policy controls
the many settings used to print and display portlets for a project.

Project Security. The Project Security policy determines whether a
summary task owner can edit the summary tasks assigned to them, as well
as the users who can view the project and its cost data.

For more detailed information on project policies and instructions on how to
configure each of them, see the HP Project Management User’s Guide.

Chapfer 6



Configuring Project Participants

In HP Project Management, project participants belong to one or more of the
following groups:

Project managers. Project managers take part in project planning and
management, and oversee project execution, issue resolution, and budget
management.

Stakeholders. Stakeholders are users who do not work on a project, but are
interested in and need to be updated on project status and progress.

Resources. Resources are project team members who work on project
tasks, but do not have the administrative responsibilities of a project
manager.

Summary Task Owners. Summary task owners are the people named on
summary tasks who have oversight over associated sections of the work
plan.

Program managers. Program managers are responsible for managing a
collection of projects and their associated scope changes, risks, issues, and
resource requests.

You can add participants to a new application project from the Configure
Project Participants page, which is shown in Figure 6-2.

Figure 6-2. Configure Project Participants page

Configure Project Participants - PRim Link Save | Done | Cancel
Below are all of the groups that have a relationship to this project
Project Managers Resources
Name Type Thiz group has no members.
X Admin User User —
Summary Task Owners
MJ Thiz group has no members.
Stakeholders Program Managers
Name Type Thiz group has no members
Add Stakeholder... *
Save | Done | Cancel

To open this page from the Project Overview page, click Configure
Participants. For detailed instructions on how to add project participants, see
the HP Project Management User’s Guide.
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CMQC - Application Project Workflow

The application projects that you create follow the CMQC - Application
Project workflow.

The CMQC - Application Project workflow is the default workflow attached to new
) application projects. You can create and assign a different workflow for a project. For
information on how to create a workflow, see the HP Demand Management
Configuration Guide.
To view this workflow in the PPM Workbench:
1. Log on to PPM Center.
2. From the menu bar, select Open > Administration > Open Workbench.
The PPM Workbench opens.
3. From the shortcut bar, select Configuration > Workflows.
The Workflows Workbench opens.
4. Click List.
5. In the Workflow Name column, double-click CMQC - Application Project.

The Workflow window opens to the Layout tab, which displays a graphical
view of the workflow. Figure 6-3 shows the layout of the CMQC -
Application Project workflow.

Table 6-2 on page 95 provides descriptions of each step in the workflow,
which is based on the best practices for application delivery.
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Figure 6-3. Layout of the CMQC - Application Project workflow
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Phases of the CMQC - Application Project Workflow

The CMQC - Application Project workflow includes three major phases:
Phase 1. Submit a CMQC application project in PPM Center.
Phase 2. Define and create a Quality Center project.

Phase 3. Follow the software development life cycle (SDLC) through
application design, development, testing, and deployment.

During Phase 1, a user in an LOB or member of the Quality CoE on behalf of
an LOB creates an application project. The application project information
includes high-level objectives and requirements for the project, including
initial justification, business need, completion time, and resource estimate.

As the project passes through the workflow, the project manager configures
ownership and resource assignments, business case details, value and risk
ratings and project health metrics. For each stage of the application delivery
lifecycle, the project manager assigns leads to be responsible for the
completing of a set of steps in the workflow. The development lead is
responsible for delivering the application to QA for testing. The QA lead is
responsible for initiating a Quality Center project, managing the testing effort,
and providing quality metrics and status. The operations leads are responsible
for helping to deploy the application.

The project manager creates a work plan—usually by using a work plan
template provided with CMQC. The project manager then either references an
existing PPM Center project or creates a new PPM Center project to assign to
this work plan.

Table 6-2 lists the details of this phase of the application project workflow.
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Table 6-2. Steps in the CMQC - Application Project workflow (page 1 of 3)

Step Name Description

Phase 1

1. New A new request for initiating a project is created.
The project manager assigns owners for key

5 Assign Responsibilities staggs in the application dellve_ry lifecycle, such as
application development, quality assurance, or
operations.

3 Verify Work Plan Exists Th.e project manager verifies that a work plan
exists.

4 Select Work Plan Type The project manager selects a work plan type to
create.

5. Set Work Plan Temp The project manager selects a work plan template.

6 Create Work Plan From | The project manager creates the new

' Template template-based work plan.

If step 6 was successful, continue to step 8. If step

7. OR )
6 failed, return to step 3.

Phase 2

8. Define QC Project The QA lead creates a QC project.

. A QC Administrative Request is created by the
9 Create Project user for the purpose of requesting a new QC
' Administrative Request .

project.
After a QC project is created, the project manager
or QA lead provides all required information and

10. | QC Project Setup submits the request for verification. The CMQC
Administrative Request used to create the QC
project is closed or completed.

11. | Verify Project in QC yerlfy the information provided for the QC
instance.

12. | Create Requirement Qreate or verlfy the test requirement path provided
in the QC project.
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Table 6-2. Steps in the CMQC - Application Project workflow (page 2 of 3)

Step Name Description
13. | AND If thg requirement was successfully created,
continue to step 14.
14 Detailed Project The project manager defines detailed project
" | Definition requirements.
15 Business Readiness Application project is pending approval and
" | Sign Off sign-off from program or project manager.
16. | Requirements Qreate or verlfy the test requirement path provided
in the QC project.
17. | Design Application is designed.
Application is developed and, when it is ready,
18. | Develop ready, it is submitted for testing.
Phase 3
19. | Setup Testing Method The _QA_Iead sets up the method for testing the
application.
Create and attach new | The QA lead creates a testing project to associate
20. ) : o :
testing project it with the QC project.
21 Verify and Attach The testing project is verified and attached to the
" | Testing Project QC project.
22. | Testing Completed? The as_S|gne_d QA_ Iea_d or the project manager
determines if testing is completed.
23. g{; ?S: Testing Request The status of the testing project request is verified.
24 | Manual Test Manually test th_e application and document the
results (pass/fail).
Confirm that the application quality passed testing
25. | Post Testing Evaluation | requirements and the application is ready to
deploy.
26. | Deploy Deploy application as per the standard SDLC
process.
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Table 6-2. Steps in the CMQC - Application Project workflow (page 3 of 3)

Step Name Description
27. | End of Project The project reaches its end.
28. | Create Asset Create asset for the application.
29. | Project Completed The application project request is closed.

In parallel with the PPM Center project creation, the project manager or QA
lead must specify a QC project to track testing requirements, assets, and results
for the application project. Either a new or existing QC project may be
assigned to this application request. To create a QC project, the QA manager
submits a QC Administrative Request, which must be completed and closed
before continuing. (For more information on the QC Administrative Request,
see Chapter 10, Managing Quality Center of Excellence Administrative
Activity, on page 165).

Once both the PPM Center project and the QC project have been created and
assigned to the request, the application project can continue through the
design, development, testing, and deployment workflow phases. The project
definition and requirements must be signed off by all required stakeholders and
the design and development steps must be completed before the application is
ready for testing. The testing cycle consists of setting up and assigning the
testing request or performing a series of manual tests. For details on the testing
project type, see Chapter 5, HP Center Management for Quality Center QA
Testing Projects, on page 49.

Creating and Managing Work Plans

A work plan is a vital tool that organizes specific project tasks and deliverables
into a hierarchical structure that makes project work easier to prioritize and
track. It covers the all project requirements and the steps required to meet
them. It helps to keep a project team aware of what they need to do and when
they need to do it.

Project managers oversee work plans to ensure they accurately reflect current
project status through all phases of the project lifecycle. With a well-managed
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work plan, a project team always knows what work has been completed, and
what work remains to be done.

The work plan contains the work breakdown structure of the application or
testing project, which defines such project elements as:

e Task hierarchy

e Resources or skills assigned to tasks

e Task and project schedule

e Project exception monitoring

e Project milestones

e Baselines

e Project budget

e Expected cost and effort

e Import a work plan from Microsoft Project

e Build a work plan from scratch.

Work Plan Templates

Work plan templates are used in HP Project Management to create repeatable
processes to be used as a model and basis for new projects. These templates
speed up work-plan setup.

A work plan template consists of a reusable set of tasks that you can use to
create a work plan and at the same time preserve any notifications, resource
assignments, and predecessors. For example, a company with several different
software product projects might use the same workflow for all development
efforts. Instead of creating a separate work plan from scratch for each new
project, the company can use a work plan template to quickly create the work
plans. A project manager can modify information for an individual project, as
needed.
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The default workflows for CMQC projects require that you associate a work
plan with the project. You do this from HP Project Management.

PPM Center provides two work plan templates for CMQC projects. The
CMQC - Sample SDLC Plan is designed for creating work plans for CMQC -
application projects, and the CMQC - Sample Test Plan template is designed
for creating work plans for CMQC testing projects.

If the CMQC - Sample SDLC Plan template does not suite your needs for
CMQC - application project work plans, you can revise it, or create a template
from scratch to better address your project needs.

To view the CMQC - Sample SDLC Plan template:
1. Log on to PPM Center.

2. From the menu bar, select Open > Administration > Project Types and
Templates > Manage Work Plan Templates.

The Manage Work Plan Templates page opens.

Manage Work Plan Templates

® Export to Excel

Select a Template

Enabled Template Owner

Admin User re development lifecycle plan

PR =]

Admin User st plan for testing projects

Craate Work Plan Template |

3. In the Template Name column, click CMQC - Sample SDLC Plan.

CMQC - Sample SDLC Plan

Template Name: CMQC - Sample SDLC Plan

Enabled: @ ves OMo
Template Owner: Admin User &
Description: A sample software development lifecycle plan
Configure Access | Edit Work Plan Template | copy| Delete save | Done | Cancel

4. Click Edit Work Plan Template.
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Work Plan Template: CMQC - Sample SDLC Plan

oons

Expand to: (Sl e=| 2= || F|| 4| x| & 00| B || ] | e DR | votai Tasks o

seq | Name

0

w|n =

=l cmac - sample SOLC Plan
Requirements
Design
Build
Test
Implement
Validate
Train

Release

Scheduled
Duration

136.00
10.00
20.00
0.00
20.00
10.00
3.00
10.00
3.00

Scheduled
Effort (hrs) Predecessors | Resources

1,088.00
80.00
160.00
480.00
160.00
80.00
24.00
80.00
2400

Seq#

Role

o|[=l

Activity

For detailed information about how to create and edit work plans and
work-plan templates in PPM Center, see the HP Project Management User’s

Guide.
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7 Viewing and Tracking Project Progress and
Quality

Overview of HP Center Management for Quality Center PPM
Dashboard Portlet Content

>»

CMQC delivers preconfigured PPM Dashboard content that provides a
comprehensive, real-time view of project status and key performance metrics.
These portlets provide visibility to various content for managing and running a
CoE. Quality Center-specific portlets show cross-project information.

The various portlets and pages are available to you depend on your role on a
team or project. (Delivering Role-Based PPM Dashboard Views on page 43
provides descriptions of the preconfigured PPM Dashboard pages and portlets
available to users based on roles.)

For detailed instructions on how to distribute PPM Dashboard modules, see the PPM
Center Configuring the Standard Interface guide.

After an application or testing project request is created, you can view its
details and track its progress from the PPM Dashboard. This chapter provides
information about the CMQC role-based portlets displayed in PPM Center.

PPM Center portlets query data using direct SQL calls to the Quality Center data
model. This is the only method used to get data from Quality Center.

HP Center Management for Quality Center IT Service Portlets

Table 7-1 lists the IT service-related portlets available for CMQC.
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Table 7-1. CMQC IT Service portlets

Portlet Name

Description

CMQC - Issue Priority

Shows the breakdown of IT service requests based
on issue priority.

CMQC - Issue Status

Shows the breakdown of IT service requests based
on status.

CMQC - IT Service Open
Administrative Requests

Lists all administrative requests that are either open
or that have been escalated.

CMQC - My IT Service
Requests

Lists all IT service requests that were either created
by or assigned to you.

CMQC - Open IT Service
Requests

Lists all IT service requests that are either open or
that were escalated.
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Table 7-2 lists the preconfigured application quality-related portlets available

for CMQC.

Table 7-2. CMQC Quality portlets (page 1 of 2)

Portlet Name

Description

CMQC - Business Value
Map

Bubble chart that shows the breakdown of application
project budget size as a function of business value and
business risk. Bubble size represents budget size.

CMQC - Defect
Breakdown By Status (%)

Shows the percent breakdown of defects by status for
selected projects. Defect status is based on the most
recent test status report. If a test status report was not
completed for the project, no data is shown for that
project. Data can be displayed in a clustered bar chart,
a stacked bar chart, or in a list.

CMQC - Defect by Status
Trending

Shows the trend of total defects over time period for
selected projects. Trending data is based on the test
status report created during the sampling interval. If a
test status report was not completed for the project, no
data is shown for the project.

CMQC - Defect by Status
Trending (Drill Down)

Displays a graph that depicts trending of defects based
on status over time for a project.

CMQC - Defect Density
Over Time

Displays bar chart that depicts defect density (open
defects/requirements) over time for selected projects.

CMQC - Defects
BreakDown By Status (#)

Shows a breakdown of the number of defects based on
the most recent test status report for selected projects.

CMQC - Generic User
Query (CM)

Displays results of user-defined query for selected
environments.

CMQC - Open Priority
Defect Trending (%)

Shows the percentage total defects that are open for
selected projects over time.

CMQC - Project Listing

Overview of application or testing projects and their
status, owners, and project details.

CMQC - Quality Center
Defects (CM)

Displays a list of defects from selected Quality Center
projects.

CMQC - Quality Center
Instances

List of Quality Center instances and their respective
status values.

Viewing and Tracking Project Progress and Quality
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Table 7-2. CMQC Quality portlets (page 2 of 2)

Portlet Name

Description

CMAQC - Quality Center
Project Status (CM)

Displays requirements, test execution, and defect
status from selected Quality Center projects.

CMQC - Quality Center
Requirements (CM)

Displays a list of requirements from selected Quality
Center projects.

CMQC - Quality Center
User Query (CM)

This portlet lets you define a custom query against any
number of Quality Center projects and display the
results in tabular form. The portlet also provides
aggregation capabilities to sum values for any of the
defined numerical columns.

CMQC - Requirement
Coverage by Status

Horizontal stacked chart that shows the percentage of
requirements having the different status values
(Passed, Failed, Not Run, Not Completed) for selected
projects.

CMQC - Requirement
Coverage Trending (%)

Shows the percentage of test requirements covered
over time for selected projects.

CMQC - Requirement
Coverage Trending (Drill
Down)

Stacked bar chart that shows the number of test
requirements over time for a project.

This view shows the trend in the number of test
requirements based on status over time for a project.
Trending data is based on the creation date of the test
status reports submitted against the testing project. If a
test status report was not submitted for a project over a
specific sampling interval, then no data are shown for
the project during that interval.

CMQC - Skillset
Coverage

Shows the breakdown of skills of selected users based
on proficiency.

CMQC - Test Execution
Status Trending (Drill
Down)

Stacked bar chart that shows the trend in the number of
test scripts for a project over time.

CMQC - Web Frame
Portlet (CM)

URL portlet
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Viewing and Tracking Project Activity

This section provides detailed information about the CMQC portlets that you
can use to monitor project activity and progress.

CMQC - Project Listing Portlet

The CMQC - Project Listing portlet shown in Figure 7-1 ties together PPM
Center project status based on timelines, risks, and scheduling with the Quality
Center quality statuses. It lists application and testing projects, and displays
real-time status values for project requirements, testing, and defects, as well as
the overall quality of each project within Quality Center.

The portlet in Figure 7-1 also displays project progress and quality status
values, workflow status, and the names of people responsible for different
stages of project delivery (project manager, development lead, QA manager, or

operations lead).

Figure 7-1. CMQC - Project Listing portlet
CMQC - Project Listing =
Preferences: Include Closed: ez
Project Hame Type Project = Description Project Overall | Requirements Testing Defect R T D Workflow Last
Status Manager | Quality | Status Status Status Status Updated
Widgets 2.0 cMac - O Widgets 2.0 Admin [ | "5' _l & CheckTest 2/5/08
Application User Completion
Project Status
Type
TESTING_NILESH cMac - [m] Admin °$y A = Configuring 1/31/08
QA User ac
Testing
Project
Type
TESTING_NEW_NB ( a Create a Admin % A ® Processng 12108
new Testing User
Project
cmac - ga testing Dezcription: Admin [ | 7} _i. & Closed 1/31/08
project User
Widgets 2.0 - QA D Widgets 2.0 Admin D D . °§ l ¢ In Testing 2/5/08
User
Type
Inreads App cMac - O Inroads App Admin °§; _l. %%, Pending 213108
Application User Aszsignment
Project
Type
Showing 1to 10 of 11 Next| I1aximize
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You can drill down to view the details of requirements, testing, and defects to
examine the Quality Center data from which the displayed metrics are derived.
For example, in the U column, you can double-click a defect trend link (=) for
a project to view an historical trending view of defects. From there, you can
drill down further to view a list of pending defects, and, finally, drill down on a
specific defect to launch Quality Center and view its details.

The workflow status shows where the project is in its software development
lifecycle. A project manager can view the project status from PPM Center, and
all of the quality metrics and status from Quality Center within a single view.

e Project status based on timelines and risks

e Quality status indicators, based on Quality Center results
e Trend analysis of requirements, tests, and defects

e SDLC or testing status

You can drill down to the trend analysis of the particular requirements, defects,
or testing statuses. You can drill into it graphically, you can actually drill
through a specific defect, for example, and start Quality Center from that
defect.

The CMQC - Project Listing portlet shown in Figure 7-1 displays a list of
application and testing projects, along with their progress and quality status
values, workflow status, and the names of people responsible for different
stages of project delivery (project manager, development lead, QA manager, or
operations lead).

By default, the CMQC - Project Listing portlet lists the active projects to which
you have access. However, filters can be set to show specific additional
projects or projects managed by another user. If the portlet is set to exclude
closed projects, it displays only active application and testing projects.

Table 7-3 lists the fields available for display in the CMQC - Project Listing
portlet.
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Table 7-3. Fields available for display in the CMQC - Project Listing portlet

(page 1 of 3)

Field Name

Description

Type

The type of project (application project or testing project).

Project Name

Project name and link to the project detail page.

Project Status

Project status based on the work plan, milestones, and
tasks:

[ Indicates that the project is on schedule.

Indicates that the project schedule may be at risk with a
few scheduling exceptions.

M Indicates that the project is at risk, with multiple
scheduling exceptions.

Description

Project description, including project name, application, and
version information.

Project Manager

Username of the resource who manages the project.

Overall Quality

Overall project status based on quality indicators. Rating is
based on the last test status report submitted by QA for this
project, as follows:

[ Indicates that product quality is good.
Indicates that product quality is mediocre.
M Indicates that product quality is poor.

Requirements Status

Requirements coverage data based on Passed, Failed and
Pending status. Rating is based on the last test status
report submitted by QA for this project, as follows:

[ Indicates that most or all requirements have been met.

Indicates that several high-priority requirements have
failed.

B Indicates most requirements have failed or have not
been covered.

Viewing and Tracking Project Progress and Quality
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Table 7-3. Fields available for display in the CMQC - Project Listing portlet

(page 2 of 3)

Field Name

Description

Testing Status

Status of test script execution and maintenance. Rating is
based on the last test status report submitted by QA for this
project, as follows:
[ Indicates that most test scripts have passed.

Indicates that several test scripts covering high-priority
requirements have failed.

M Indicates that many test scripts have failed or were not
completed.

The status of product based on defects. This rating is based
on the last test status report submitted by QA for this
project.

Defect Status [ Indicates that no critical or high-priority defects exist.
Indicates that several critical or high-priority defects are

unresolved.
B Indicates many critical or priority defects exist.

R A link (#:) to requirements coverage trend view for this
project.

T Alink (L) to test execution trend view for this project.

D A link (=) to defect trend view for this project.

Workflow Status Current workflow step of the project.

Last Updated Calendar date on which the project request was last
updated.

Priority Assigned project priority.

Project Sponsor

Username of the person who sponsors the project.

R&D Manager

Username of the person who leads the development effort
for the project. (In maximized view only.)
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Table 7-3. Fields available for display in the CMQC - Project Listing portlet

(page 3 of 3)
Field Name Description
Username of the person who leads the QA activities for the
QA Manager . o .
project. (In maximized view only.)
Username of the person who leads the implementation and
OPs Manager deployment activities for the project. (In maximized view

only.)

For a detailed view of the project status and trends, drill down into (click) the
individual project indicators.

For information on how to modify a portlet in PPM Center, see the
Configuring the Standard Interface guide.

CMQC - Business Value Map Portlet

The CMQC - Business Value Map portlet (Figure 7-2) displays a bubble chart
that shows the distribution of application projects based on business value and
business risk. The size of the bubble indicates budget size expressed in
thousands (of selected currency units).

Figure 7-2. CMQC - Business Value Map portlet

CMQC - Business Value Map
Preferences: Project Type: CMQC - Application Project..
Business Yalue vs Risk

Business Value (0:Low - 5:High)

©

0
Business Risk (0:Low - 5:High)

Size of Bubble indicates # of Projects

You can retrieve data for display in the portlet based on project type to display
all project requests of selected project types that support business value and
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risk ratings. You can also retrieve data based on project manager name to

display all project requests that support business value and risk ratings for
selected project managers.

Application Quality Portlets

CMQC - Defects BreakDown By Status (#) Portlet

The CMQC - Defects BreakDown By Status (#) portlet (Figure 7-3) displays a
breakdown of the number of defects based on the most recent test status report
results for selected projects.

Figure 7-3. CMQC - Defects BreakDown By Status (#) portlet

CMQC - Defects BreakDown By Status (#) =i

Display: | Stacked Bar Chart | W

Defect Breakdown by Status (#)

Project Name

cMaQcz0

o &0 100 150 200 250 300 350
# of Defects

Walue

l:‘ Open Low . Closed . Open High

Total: 334

The number of closed defects, open high priority defects, and open low priority
defects are represented along x axis. Project names are displayed along the y
axis. If a QA test status report was not completed for a project, no data is
shown for that project.
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CMQC - Defects Breakdown By Status (%) Portlet

The CMQC - Defects Breakdown By Status (%) portlet (Figure 7-4) shows the
percent breakdown of defects based on status for selected projects. The defect
status is based on the most recent QA test status report submitted for the
project.

Figure 7-4. CMQC - Defects Breakdown By Status (%) portlet

CMQC - Defect Breakdown By Status (%) =i

Defect Breakdown by Status (%)

Project Name

CMQC 2.0

0 20 40 Go 20 100
Fercentage (%)

Defect Status
|:| Open Low . Closed . Cpen High

Total: 100

The number of closed defects, open high priority defects, and open low priority
defects are represented along x axis. Project names are displayed along the y
axis. If a QA test status report was not completed for a project, no data is
shown for that project.

To view the actual number of defects represented by a colored bar in the chart,
move your cursor to that bar to reveal the tooltip text. The tooltip for each
displays the actual number as well as with the percentage of defects that have
the status indicated. You can choose whether to display closed defect data.
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CMQC - Defect by Status Trending Portlet

The CMQC - Defect by By Status Trending portlet (Figure 7-5) displays the
trend of the total number of defects over a specified time period for selected
projects. Trending data is based on the QA test status reports created during the
sampling interval.

Figure 7-5. CMQC - Defect by By Status Trending portlet

CMQC - Defect by Status Trending 7 [~ O]

Total # of Defects Over Time

#of Defects

350
300
250
200

150

100
&0
o]

JAN 14, 2008 JAN 21, 2008

Periad Narme

Defect Status

. Close . Open

Total: 422

Sampling intervals are represented along the x axis, and the number of defects
is represented on the y axis. If no QA test status reports were created for a
project, no data is shown for that project.

To view the actual number of defects represented by a colored bar section in
the chart, move your cursor to that section. The tooltip for each displays the
number of defects, as well as with the percentage of defects represented.

You can retrieve data for display in this portlet based on trend type (for
example, daily, weekly, or monthly intervals). Y ou must specify the date range
that you want represented in the chart.
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CMQC - Defect Density Over Time Portlet

The CMQC - Defect Density Over Time portlet (Figure 7-6) displays the
number of open defects in relation to requirements over time for selected

projects.
Figure 7-6. CMQC - Defect Density Over Time portlet
CMQC - Defect Density Over Time ==
Detect Density Over Time

Ipen Defects over Requirements Density
a7
16
15
14
13
8 j
31

o

JAN 14, 2008 JAN 21, 2008
Period Name
Project Name
[ Mercury Taus Upgrade Test... [l sAP Netweaver Upgrade- W... Wl sAP Netueaver Upgrade - W...
Total: 1.88

Time is represented along the x axis and the number of open defects relative to
requirements is represented on the y axis. You can select the time interval, or
trend type (for example, daily, weekly, or monthly) displayed on the x axis.

In this portlet, each project is represented by a single color. The tooltip for each
colored bar displays the actual number of defects and the defect density ratio
for that sampling interval.

CMQC - Generic User Query (CM) Portlet

Any user can use the CMQC - Generic User Query (CM) portlet to generate
custom queries against multiple Quality Center instances and display the
results in tabular form. The portlet can also aggregate and display total values
for any defined numerical columns.

Preferences are available to filter the information in the portlet view. These
options are described in Table 7-4.
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The initial query is run separately in each Quality Center instance specified,
and the results are combined into a single set for display in the portlet.

You can use the Extended Query box in the SQL Logic section to impose
additional logic on the combined results from the initial queries. Suppose, for
example, that you perform an initial query for a list of defects from three
separate Quality Center instances. Then, to display the total number of defects
in each category, you would use the extended query to perform this logic. This
way, defects of the same category from different QC instances would be
included in a single count.

Note that there is a limitation to be aware of when performing an extended
query; the capability to insert hyperlinks to items in their respective QC
instances is only supported for the initial query, and not for extended queries.
Consider using extended queries only in scenarios that require summary or
aggregate data. An extended query is not necessary if, for example, you simply
want to display a list of defects. The combined result set from the initial query
supports basic sorting capabilities, and you can display hyperlinks for each
defect listed in its respective QC instance.

114 Chapter 7



Table 7-4. Filters for sefting data display preferences for the CMQC - Generic

User Query (CM) portlet (page 1 of 3)

Filter Name

Description

Filter By User

Specify the list of users for which to retrieve information. To use

this value in the SQL query, the following tokens are defined:

e [Q.USER] - Set to ‘1’ if the user filter is either Current or
Specified list of users, or ‘0’ for everyone.

e [Q.VP.USER]- A comma-delimited list of user names (user1,
user2, user3, and so on).

The portlet automatically substitutes the tokens with their literal
values before running the query. You can use the token as
many times as necessary in the SQL expression.

Creation Date
From

Specifies a from date filter. In order to use this value in the SQL

query, the following tokens have been defined:

e [Q.CREATED.FROM)] - Set to 1 if 'From' date filter is
specified, otherwise 0.

e [Q.VP.CREATED.FROM] - Set to the date. SQL bind
variables are used to pass the date value.

The portlet automatically substitutes the tokens with their literal
values before running the query. You can use the token as
many times as necessary in the SQL expression.

Creation Date To

Specifies a to date filter. In order to use this value in the SQL

query, the following tokens have been defined:

e [Q.CREATED.TO] - Set to 1 if 'To' date filter is specified,
otherwise 0.

e [Q.VP.CREATED.TQ] - Set to the date. SQL bind variables
are used to pass the date value.

The portlet automatically substitutes the tokens with their literal

values before running the query. You can use the token as

many times as necessary in the SQL expression.

Sort Order

To determine the sort order of the listed results, select either
Ascending or Descending.

*Rows Displayed

Use this field to specify the number of rows to display in the
default view.

Viewing and Tracking Project Progress and Quality
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Table 7-4. Filters for setting data display preferences for the CMQC - Generic

User Query (CM) portlet (page 2 of 3)

Filter Name

Description

*Rows Displayed
in Maximized
View

Use this field to specify the number of rows to display in the
maximized view.

Display Columns

To make a column visible, move its name from the Available
list to the Visible list. To change the display order for a column,
select its name in the Visible list, and then use the up and
down arrows to move it.

SQL Query logic

Each set of environment queries includes the target database
environment, SQL query, and target result table. The target
result table is used by the extended query (if defined). You can
define any number of environment queries. To add
environment queries, define query information in existing
environment query sections, and save preferences. A new
empty environment query will be added.

Environment

Name of an environment object. Only environment objects that
the logged on user can access are listed. An environment can
point to either an Oracle database or an MSSQL database.

Query

A valid SQL expression executed against selected environment
database.

Guidelines for forming a SQL query are as follows:

e You can only use a SELECT statement in this query.

e The SQL statement must be valid for the database type
referenced by the environment (MSSQL and Oracle).

e Instead of using DECODE (. . . ), which works only for
Oracle, consider using:

case
when (conditionl) THEN resultl
when (condition2) THEN result?2

else resultN
end
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Table 7-4. Filters for setting data display preferences for the CMQC - Generic

User Query (CM) portlet (page 3 of 3)

Filter Name

Description

Result Table

If an extended query is defined, this field is used to specify the
name of a temporary table in which the results of the query are
to be stored. The extended query can reference the results of
each environment query by this result table name.

Extended Query

Extended query is executed on the results of the environment
queries defined. This allows the user to perform
cross-environment queries (aggregate data from multiple data
sources). The SQL statement must be a valid SELECT
statement against the result table name(s).

If an extended query is not defined, the results displayed in the
view are based on Environment Query #1 (only).

Note: You cannot use the filter tags [Q.*] or [Q.VP.*]in an
extended query.

SQL Columns

To display the result columns, you must define the list of
columns and specify their display order. If you use an extended
query, the column properties must correspond to the results of
the extended query. Otherwise the column settings must
correspond to the per-project SQL query. This section lets you
add, edit, remove, or rearrange columns.

A column has the following properties:

e SQL Column Name. The name of the column in the SQL
query.

e Column Title. The title of the column, as it will appear in the
table's column header.

e Column Width. The width of the column (Small, Medium, or
Large).

e Is Date. Flag to display the column as a date.

e Aggregate. Sum the numeric value of the column and

display total in table's column footer. Useful for aggregating
results across projects.
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Changes to CMQC Data Sources

If HP Center Management for Quality Center (CMQC) is deployed on your
PPM Center 7.5 instance, when you upgrade to PPM Center 8.00, the
following data sources are updated in accord with the new data model:

e CMAQC - Requirement Coverage Trending
e CMAQC - Open Priority Defects Trending
e CMQC - Defect by Status Trending

e CMAQC - Defect Density over Time

Existing portlet definitions are redirected to these updated data sources.
Validations are updated on the Preferred User Table Space and Preferred
TEMP Tablespace fields in the CMQC - QC Instance Registration request type
and on the Oracle User Table Space and Oracle TEMP Table Space fields in
the CMQC - QC Project Administrative Request request type.

After you upgrade from PPM Center 7.5 instance to PPM Center 8.00, you
must reinstall CMQC version 2.0 software.

HP Center Management for Quality Center Reports

CMQC provides preconfigured reports that mirror the content of two important
portlets. However, unlike portlets, which query and display information only
when the you view the PPM Dashboard, you can configure these reports to run
at regular intervals, and to be actively shared by or emailed to all interested
shareholders. You can run the reports to generate HTML or CSV files, which
you can then use to produce custom multi-purpose reports or graphs in various
formats.

CMQC - Cross Environment Query Reports

The CMQC - Cross Environment Query report content mirrors the content of
the Generic User Query (CM) portlet, and provides similar viewing options.
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This report queries multiple database environments and aggregates the results
into a single table.

Creating a CMQC - Cross Environment Query Report
To create a CMQC - Cross Environment Query report:
1. Log on to PPM Center.

2. From the menu bar, select Open > Reports > Create Report.

The Submit New Report page opens.

[} Project and Portfolio Management Center User: Admin User | Sign Out
Dashboard + Open » Search » Create » My Links » History ¢ Search menus or entities...
Manage Work Plan Templates > Create Project Type > Create New Project > Manage Work Plan Templates > Submit New Report
Submit New Report

Recently Submitted Reports

Select Report by Category

Report Category: | Select Category b

Select Category
Administrative
Deployment Management
| Demand Management
Financial Management
Portfolic Management
Pregram Management
Project Management
Rezource Management
Time Management
Extension
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3. From the Report Category list, select either Demand Management or Project

Management.

Links for the reports that belong to the selected category are listed, along
with a brief description of each.

roject and Portfolio Management Center User: Admin User | Sign Out

Dashboard + Open » Search » Create » My Links » History ~ 1 Search menus or entities...

Submit New Report

Manage Work Plan Templates > Create Project Type > Create New Project > Manage Work Plan Templates > Submit New Report

Recently Submitted Reports

Select Report by Category

CHQC - Cress Environment Guery
port

CMQC - Quality Center User Query
port

Contact Detail Report
Demand Creation History Repert

Histerical SLA Viclatiens

- Change Summary Report

- Forward Schedule of
azes
WAC - Forward Schedulz of
anges for RFC

Content Report
MAC - Releaze Summary Report

Request Detail (Fiter by Custom
Fielda} Report

Request Detail Report

Guery multipls database environments and aggregate rzzults into a shgle tatile.
Cuery multiple Quality Center projects and aggregrate resultz into a =ngle table.

View the detailz of one or more contacts

Demand Creation history by peried and by various demand fields. Useful for exportng request data to MS Excelor
other data analyziz tools.

Hiztorical SL& Viclations period and by various demand categories. Useful for exporting request data to MS Excel or
other data analyziz tools.

Change Summary Report
Forward Schedule of Releases

Forward Schedule of Changes for RFC requests

Release Content Report
Releaze Summary Report

Audit the detailz of one or more reguests, which can be fitered by a request twpe's custom field values. Includes
header and destail informaticn, notea, and etatua for each aslected requssat.

Audit the detailz of one or more requests. Includes header and detail nformation, netes, and status for each sekected
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Submit Report: CMQC - Cross Environment Query Report

4. Select the CMQC - Cross Environment Query Report link.

= Report Parameters

“Title:

ENVIRONMENT SECTION 1

“Hame 1:

“Query 1

ENVIRONMENT SECTION 2

HName 2

Query 2

ENVIRONMENT SECTION 3

HName 3:

Query 3

EXTENDED QUERY SECTION

“Extended Query:

QUTPUT RESULTS SECTION

“Results Format:

“Column 1:

Column 2:

Column 3

Column &

Column 5;

Column 6;

Column 7:

Column &

Column &

Column 10:

Column 11:

Column 12

Column 13:

Column 14:

Column 15:

(Required) Pleas:
allowred).

1

lect a database environment and specify a valid SOL query (only SELECTs

1t

(Optional) Please select a Gatabase envirenment ang speciy a vaiid SQL query (only SELECTs

allow

1

iTe

(Optional) Pi
allowied

1

ot a database environment and specify a valid SQL query {only SELECTs

(Required) Pleas cify a valid SQL query (only SELECTS allowed) against the resut tables of
E ed above.

(Required) Specify table columns to display. Syniax of each column entry
Names::<Column Ttie=::<Column Width> :<Is Date (Y/M)>:<Display As (Html
\Z0

SQL Column
x> 1<AQQregate

= Scheduling and Output Options

@ Run Report Immediately

e e —
Repeat Every |:| Hours

R —

[] send email to: |~

o | 18] when report is finished

# Advanced Notificati

ons.
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5. Complete the following fields.

Field Name .
(*Required) Description
Title Type the report title in this field.
ENVIRONMEN Use each ENVIRONMENT SECTION t(_) select_up to
T SECTION three database environments and specify a valid SQL
SELECT query for each. Only the Environment Section
(1,2,and 3) 1 fields are required.
. From the auto-complete list, select the environment
Name 1
name.
Result Table Type a name for the table that is to contain the query
results.
*Query 1 Type a valid SQL SELECT query against the selected
ry environment (in the Name field).
(EQ)L(JTET:::(DED Use this section to create an extended SQL SELECT
SECTION against more than one environment.
*Extended In this field, type a valid SQL SELECT query against the
Query result tables of the environment queries you specified.
OUTPUT . . . .
RESULTS Use this section to specify table columns to display.
*Results To specify the format to use to display the results, from
Format this list, select CSV or HTML.
Use each Column (1, 2, 3, ...N) row to specify a column
to include in the report.
Column 1, Use the following syntax for a column entry:

Column 2, and
soon

<SQL Column Name>::<Column
Title>::<Column Width>::<Is Date (Y/
N)>::<Display As_ (Html/
Text)>::<Aggregate (Y/N)>

Scheduling
Run Report Specifies that the report is to be run immediately after
Immediately you configure it. This is the default scheduling option.
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Field Name
(*Required)

Description

Run Report On

To specify a date on which to run the report, select this
option.

Using the date chooser, select the date and time to run
the report.

To run the report periodically after the first run:

1. Select the Repeat Every checkbox.

2. From the list, a unit of time (Hours, Minutes,
Weekdays, and so on) to use to specify the run interval.

3. In the field to the left of the list type the number of time
units to use to specify the run interval.

4. Use the Until auto-complete to specify the end date
for the repeated report runs.

Send email to

To send email notifications to specific users after the
report is run, select this checkbox, and then use the
auto-complete to select the notification recipient(s).

The recipient(s) can use the View Report and View
Report Log links in the email notification to open the
PPM Center logon page, and from there, view the report
or report log.

Advanced Notifications

Click Add a Notification to open the Edit Advanced
Add a Notifications window, which you can use to configure
Notification customized email messages to specific recipients after

the report run is complete.

Send When

If you configure natifications, this column displays the
events that triggers the sending of the notification. The
event can be either when the report completes, or fails,
or both.

Description

This column displays descriptions you provide (if any) for
any notifications you configure.

Recipients

This column displays the names of the recipients
specified for any notifications you configure.

6. Click Submit.

Viewing and Tracking Project Progress and Quality
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For information on how to view reports, see Viewing Reports, Report Settings,
and Report Logs on page 129.

CMQC - Quality Center User Query Reports

The CMQC - Quality Center User Query report content mirrors the Quality
Center User Query (CM) portlet content, and provides similar viewing options.
This report queries multiple Quality Center projects and displays aggregate
results in a single table.

For details on using preferences, view help for the Generic User Query (CM)
portlet and the Quality Center User Query (CM) portlet.

Creating and Running a CMQC User Query Report
To create and run a CMQC User Query report:
1. Log on to PPM Center.
2. From the menu bar, select Open > Reports > Create Report.

The Submit New Report page opens.

[} Project and Portfolio Management Center User: Admin User | Sian Out

Dashboard + Open » Search » Create » My Links + History ~ =4 Search menus or entities...

Manage Work Plan Templates > Create Project Type > Create New Project > Manage Work Plan Templates > Submit New Report

Submit New Report

Recently Submitted Reports

Select Report by Category

Report Category: | Select Category »
Select Category
Administrative
Deployment Management

Financial Management
Portfolic Managemsnt
Program Management
Project Management
Re=zource Management
Tims Management
Extension

3. From the Report Category list select either Demand Management or Project
Management.
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Links for the reports that belong to the selected category are listed, along
with a brief description of each.

[ Project and Portfolio Mana

Dashboard + Open » Search r Create v My Links v History v w

User: Admin User | Sign Out

Manage W

Submit New Report

rk Plan Templates > Create Project Tvpe > Create New Project > Manage Work Plan Templates > Submit Ne

Search menus or entitie:

Report

Recently Submitted Reports

Select Report by Category

Report Category:

cHac
port

CHQC - Quality Center Uzer Query

Report
Contact Detail Report
Demand Creation History Report

Histerical SLA Violations

- Change Summary Report
- Forward Schedule of

rd Schedule of
anges far RFC

- Release Content Report

- Release Summary Report
Request Detail (Fiter by Custom
Fielda) Report
Request Detail Report

Viewing and Tracking Project Progress and Quality

Cross Environment Query

Demand Management w

Query multiple database environments and aggregate resulte into a shgle table.
Query multiple Quality Centsr projects and aggregrate results into a engle table.

View the detailz of one or more contacts.

Demand Creation history by period and by various demand figlds. Useful for exportng request data to M3 Excelor
cther data analysis toole.

Higtorical SLA Violations period and by various demand categories. Useful for exporting request data to MS Excel or
other data analysis tools.

Change Summary Report
Forward Schedule of Releases

Ferward Schedule of Changes for RFC requests

Release Content Report
Release Summary Report

Audit the detailz of cne or more requests, which can be fittered by a request twpe's custom field values. Includez
header and detail informatien, notee, and etatua for sach aslected request.

Audit the detailz of one or more requests. Includes header and detail nformation, netes, and status for each sekcted
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4. Select the CMQC - Quality Center User Query Report link.

Submit Report: CMQC - Quality Center User Query Report

R —— “Restore Defaul

“Title: [ |

QUALITY GENTER PROJECTS  (Required) Select It of Qualty Genter projects to query against

“ac Projects: [ J

QUERY OPTIONS (Optional) Dptional parameters that may be Used by QuEry.

User Name(s): [ |

— — —m
SQL QUERY SECTION (Required) A valid SQL select statement

“Project Query:

Extended Query:

(Required) Specify table columns to display. Syntax of each column entry is: <SOL Colurn
OUTPUT RESULTS SECTION  Name»:<Column Tiie»: <Column Width»:<k Date (/M) <Display As (HimiText)>: <Aggregate
oV

“Column 1: [ |

Column 2: [ |

Column 3 [ |

Column & [ |

Column & [ |

Column [ |

Column 7: [ |

Column & [ |

Column 8 [ |

Column 10: [ |

Column 14: [ |

Column 12: [ |

Column 13: [ |

Column 14; [ |

Column 15: [ |

Scheduling and Qutput Options

(&) Run Report Immediately

R —

[ Send email tor =2+

| 18] when report s finished

Advanced Notifications

=T
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5. Complete the following fields.

(Fiﬁfqtli?;gﬁ Description

Title Type the report title in this field.

ggﬁlfgg (Required) Use this section to select the Quality Center
PROJECTS projects to query for the report.

*QC Projects

From the auto-complete list, select the environment
name.

QUERY
OPTIONS

Use this section to select optional report parameters

User Name(s)

From the auto-complete list, select the names of one or
more users assigned to the specified Quality Center
projects.

Using the date chooser, select the start date for the

From Date
report
Using the date chooser, select the end date for the
To Date
report
SQL QUERY . .
SECTION Use this section to construct your query.
*Project Query | Type a valid SQL SELECT statement in this field.

Extended Query

Use this section to specify a valid SQL SELECT query
against the result tables of project query you specified.

OUTPUT
RESULTS
SECTION

(Required) Use this section to specify the table columns
to display in the report.

*Results Format

To specify the format used to display the report results,
from this list, select CSV or HTML.

Column 1,
Column 2, and
soon

Use each Column (1, 2, 3, ...N) row to specify a column
to include in the report.

Use the following syntax for a column entry:

<SQL Column Name>::<Column Title>
::<Column Width>::<Is Date Y/N)>
::<Display As (Html/Text)>::<Aggregate
(Y/N)>

Viewing and Tracking Project Progress and Quality
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?Etiqm?gﬁ Description

Scheduling

Specifies that the report is to be run immediately after
you configure and submit it. This is the default
scheduling option.

Run Report
Immediately

To specify a date on which to run the report, select this
option.

Using the date chooser, select the date and time to run
the report.

To run the report periodically after the first run:

1. Select the Repeat Every checkbox.

2. From the list, a unit of time (Hours, Minutes,
Weekdays, and so on) to use to specify the run interval.

3. In the field to the left of the list type the number of time
units to use to specify the run interval.

4. Use the Until auto-complete to specify the end date
for the repeated report runs.

Run Report On

To send email notifications to specific users after the
Send email to report is run, select this checkbox, and then use the
auto-complete to select the notification recipient(s).

Advanced Notifications

Click Add a Notification to open the Edit Advanced
Add a Notifications window, which you can use to configure
Notification customized email messages to specific recipients after
the report run is complete.

If you configure notifications, this column displays the
events that triggers the sending of the notification. The

Send When event can be either when the report completes, or fails,
or both.

Description This cqum.n_ d|§plays descrlp_tlons you provide (if any)
for any notifications you configure.

Recipients This column displays the names of the recipients

specified for any notifications you configure.
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6. Click Submit.

For information on how to view reports, see Viewing Reports, Report Settings,
and Report Logs.

Viewing Reports, Report Settings, and Report Logs

If you scheduled a report to run immediately after submission, the report is
displayed as soon as it is generated. You can use the PPM Center menu bar to
access any report after its scheduled run.

Viewing a Report

To access a report from the menu bar:
1. Log on to PPM Center.
2. From the menu bar, select Open > Reports > View Reports.

The View Reports page opens.
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[ Project and Porffolio Management Center

User: Admin User | Sign Out

Dashboard + Open » Search » Create » My Links » History o Search menus or entities...

Create Project Type > Create New Project > Manage Work Plan Templates > Submit New Report > View Reports

View Reports

View Report % I:l Go

Search for Reports

CreateaBy: | |[&l  Repesting: [ALL v

Status: Completed
Falled
Running
Scheduled
(%) All Reports

() Scheduled Reports

All 5ched

| ﬂTD: |

All Previous Rep

Run From:

Sort By: Run Date hd | @Aacsnding ‘Maximum Results Per Page:

O Dezcending

Search

3. In the Search for Reports section, complete one or more search criteria
fields.
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4. Click Search.

The Search Results section of the View Reports page lists the reports that
match your search criteria.

View Reports
View Report # Go

[¥s ExporttoExcel

Search Results: Reports Showing 1 -4 of4
Report# | Report Type Status Created By | Run Date &
0 2012t CMQC - Cross Environment Query Report (Submission Details Completed (Log)  Admin User 5/7/08 08:07:58 PM PDT
O iz CMQC - Cross Environment Query Report (Submission Details) Completed (Log) Admin User 5708 08:08:15 PM POT

0 20123 cHa nvironment Query Report (Submission Details d (Log)  Admin User
o o124 CMQC - Cross Environment Query Report (Submission Details) Completed (Log)  Admin User Y £1:35 Pl FOT
Check Al Showing 1-4 of 4
[®s Export to Excel
Search for Reports
Report Type: |CMOC - Cross Envirenmer| [i5] Report #:
Created By: | Repeating: |ALL v
Status: Completed
[] Failed
[#] Running
[7] Scheduled
(3 All Reports

(D Scheduled Reports

5. In the Report # column, click the number that corresponds to the report you
want to view.

The selected report opens in a new browser window.

6. To print the report, in the upper right corner of the page, click Print.
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Viewing Report Settings and Report Logs
To view the settings and log for a report:

1. Log on to PPM Center.

2. From the menu bar, select Open > Reports > View Reports.

The View Reports page opens.

[ Project and Portfolic Management Center

User: Admin User | Sign Out

Dashboard *+ Open » Search » Create » My Links + History 4

Search menus or entities...

Create Project Tvpe > Create New Proiect > Manage Work Plan Templates > Submit New Report > View Reports

View Reports

viewreport®: | | [lGa

Search for Reports

Created By: I:I ﬂ Repeating: |ALL

Status: Completed
Falled
Running
Scheduled
(¥) All Reports

() Scheduled Reports

un within the next l:l
un From: | |TD:| |ﬂ

Run From: | | ﬂTD: ‘ ‘

Sort By: Run Date b | @Azcending ‘Maximum Results Per Page:
@]

Dezscending

Search

3. In the Search for Reports section, complete one or more search criteria
fields.

132 Chapter 7



4. Click Search.

The Search Results section of the View Reports page lists the reports that
match your search criteria.

View Reports
View Report # Go

[¥s ExporttoExcel

Search Results: Reports Showing 1 -4 of4
Report# | Report Type Status Created By | Run Date &
0 2012t CMQC - Cross Environment Query Report (Submission Details Completed (Log)  Admin User 5/7/08 08:07:58 PM PDT
0 a2 cHa vironment Query Report (Submission Detalls) Completed (Log)  Admin User P PDT
0 20123 cHa vironment Query Report sion Details Completed (Logj  Agmin User S P PDT

[ 20124 CHMQC - Cross Environment Query Report (Submission Details) Completed (Log)  Admin User =1:33 PII POT
Check All Showing 1- 4 of 4

[®s Export to Excel

Search for Reports

Report Type: |CMOC - Cross Envirenmer| [i5] Report #:
Created By: | Repeating: |ALL v
Status: Completed
[] Failed
[#] Running
[#] Scheduled
(3 All Reports

(D Scheduled Reports

5. To view the report setting for a listed report, in the Report Type column,
click the Submission Details link for the report.

The Submission Details page opens and displays the report settings.

) From the Submission Details page, you can click the View Report link to open the
report, or click the View Log link to open the log for the report run.

6. To view the log of the report run, in the Status column, click the Log link
for the report.

The HP Project and Portfolio Management Execution Log History page
opens. This page lists the report submission ID (the report number), the
workflow name, the workflow step that started the report run, and the time
and date on which the report run started. The page also includes the report
run completion status.
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8 Project Status Update Requests and Test
Status Report Requests

Project Status Update Requests

To keep a project team up to date on all aspects of project status, a project
manager can submit project status update requests on a regular basis. Although
a project manager can submit the request at any regular time interval, it is
considered a best practice for the project manager to issue project status
updates weekly.

The project status update request queries a QC project and gathers metrics,
which it then stores in a set of fields on the project status update request. The
data are then used to populate the project status portlets.

Over time, the collected metrics accumulate to provide enough meaningful
data for the quality status and trending portlets. You can think of the project
status update request as a periodic report to query status metrics of the QC
project and store that information in PPM Center.

The project status update request updates project status based on the following:

e A project status update request must be related to an application project or
testing project request through the Master Project field.

e Upon completion of the project status update request, the corresponding
project request's status fields are automatically updated.

e The project manager submits the project status update request to update the
QC project status information in PPM Center.
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The project status update request qualifies project health based on:

Overall project status
Scope status
Resource status
Schedule status
Risks status

Issues status

The request must be created as a child of a master project request, such as an
application project or a QA testing project.

The Project Status Update request follows the workflow shown in Figure §-1
and described in Table 8-1.

Figure 8-1. CMQC - Project Status Update workflow

T

1. Wewr - 0%

Al Results

Subrit for Review

| _Em—
E— &

Mok Approved 3. Update Status

Cancel

l

& @

5. Closed (Success) - 100% 4. Cancelled - 100%

Approved
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Table 8-1. CMQC - Project Status Update workflow steps

Workflow Step | Description

A new request for project status update request is

1. | New submitted.
The reviewer verifies the project status update request. A
notification email is sent to the CoE Manager, project

9 In Review owner, and any assigned reviewer on the status of this

project request. If the request is not approved, a
notification email is sent to the owner requesting an
update.

If the request was rejected, the request owner must
update the project status information and resubmit it for
approval. A notification email is sent to the owner
regarding the status of the project update status request.

3. | Update Status

4. | Cancelled The request was cancelled by the request owner.

5. | Closed (Success) | The request was successfully completed.

Submitting a Project Status Update Request

To submit a project status update request:
1. Log on to PPM Center.

2. From the menu bar, select Open > Center Management > Quality
Management > Project Status Update.
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The Create New CMQC - Project Status Update page opens.

ki 0] itus Update

Create New CMQC - Project Status Update

| Submit Cancel
= Header

B Instructions

« Use this form to update current status of designated project.
o The fields with * require your input.

S Summary
Request Status: New
Created By: Admin User
“Assigned Group: 1 “Assigned To: [
Description: [ |
H Project

“Master Project:

= Details

=l Assessment

Current Progress
Assessment:
B Status

Comments:
“Overall Praject Status: [

Comments:
*Scope Status:

Comments:
“Resource Status: =

Comments:
“Schedule Status: 1=

Comments:
“Risks Status:

Comments:

# Notes

# References
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3. In the Summary section, complete the following required fields:

a. To select a security group name to use to filter names for the Assigned
To field, use the Assigned Group auto-complete.

b. To select the name of the user to be responsible for completing the
project status update request, use the Assigned To auto-complete.

4. To supply additional information about this request that would be useful to
stakeholders, you can type a short description of the request in the
Description field.

If you leave the Description field empty, and you then specify a master project,
) the Description field is automatically populated with the value “Project status
update for <Project Name>.”

5. In the Project section, use the Master Project auto-complete to select the
application project to be updated.

) The project status update request must be related to an application project or QA
testing project request through the Master Project field.

6. In the Assessment section, you can type comments about overall project
progress in the Current Progress Assessment field.

) For information about the fields on this page, select the Help with CMQC -
Project Status Update link in the top left corner of the page.

7. In the Status section, complete the following required fields:

a. To select the indicator (green, yellow, or red) that best represents the
current overall project status, use the Overall Project Status
auto-complete.

b. To select the indicator (green, yellow, or red) that best represents the
current project scope status, use the Scope Status auto-complete.

c. To select the indicator (green, yellow, or red) that best represents the
current resource status for the project, use the Resource Status
auto-complete.
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d. To select the indicator (green, yellow, or red) that best represents the
current project schedule status, use the Schedule Status auto-complete.

e. To select the indicator (green, yellow, or red) that best represents the
current project risks status, use the Risks Status auto-complete.

f. To select the indicator (green, yellow, or red) that best represents the
current project issues status, use the Issues Status auto-complete.

8. In the Notes section, type any additional information you want to save
about this project status update request.

9. To add a reference to this request, in the Reference Additions section, do
the following:

a. From the New Reference list, select the type of reference to add.
b. Click Add.

The Add <Reference Type> window opens.

3 Add Document - Microsoft Internet Explorer provided by Hewlett-Packard

J
(D] Close Window X %

Add Document
“File:
Author: | Admin U
Description:
Add Cancel
v
&] Dane 9 Local intranst

c. Complete the required fields, and then click Add.

10. Click Submit.
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Test Status Report Requests

The test status report is used by the project, development, and QA teams to
track the progress of the testing effort and quality of the application. The test
status report is linked to a single Quality Center project. It queries the Quality
Center project for data on requirements coverage, review status, test execution
progress and defects trends.

Test status report results are distributed to the application stakeholders in
various PPM Dashboard portlets. It is critical that the QA manager run the test
status report on a regular basis to gain visibility into the application quality
levels, identify trends, and resolve any potential issues before they threaten the
application's business success.

CMQC provides the workflow to create a status report, complete with major
quality indicators. If additional quality metrics must be retrieved from the
Quality Center project, the QA manager should contact the PPM Center
administrator to extend the status report's capabilities.

Figure 8-2 shows the workflow that the test status report request follows.

Figure 8-2. CMQC - QA Test Status Report workflow

%

. Updsting Status Report

T — an resuis
e

1. ew

Alt Ervers,
Retrieve Status from QC AN Results

AN Resolts \ /

% % Succeeded ——

2. Initfalize Fields 4. \falidate QU Project Conmectivity 5. Updste Quality Ststus 7. Approve Report & Closed - 100%

e

hed,
Al Ervors  Skip QC Validstion Rejected

Submit Status Report —————e —— Approved —a— !}1

Validate QC Configuration

L

3. Enter QC Configuration
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Table 8-2. CMQC - QA Test Status Report workflow steps

Workflow Step

Description

New

A new test status report is submitted for
processing.

Enter QC Configuration

Details on the Quality Center instance, domain,
and project are provided. Test results will be
retrieved from this project.

Validate QC Project
Connectivity

An execution step that validates the connection
to the specified Quality Center project.

Update Quality Status

The creator or reviewer may manually update
the test results, or automate the retrieval of test
results from the target Quality Center project. (If
retrieval is automated, the user validates the
results before submitting for review.)

Updating Status Report

This execution step connects to the target
Quality Center project and retrieves statistics on
requirements coverage, requirements review
status, test execution status, and defect
statistics. Information is only retrieved for
metrics that have defined filters or
prerequisites.

Approve Report

An assigned reviewer (for example, a QA
manager, development manager, or project
manager) approves the test status report.

7.

Closed

The test status report is complete.

To submit a test status report initiation request:

1.

Log on to PPM Center.

2. From the menu bar, select Open > Center Management > Quality
Management > Create Test Status Report.
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3. In each section, complete the required fields (marked with a red asterisk)
and any of the optional fields for which you want to provide information.

Figure 8-3 shows the Create New CMQC - QA Test Status Report page.
Table 8-3 on page 145 provides descriptions of the fields in each section of
the page.

Additional information helps all stakeholders gain a better understanding of a
) project. For information about the fields in a specific section, click the [7] icon in
the section heading (where available).
4. Click Submit.

) PPM Center can be configured so that you can save the request before you
submit it. To have this feature enabled, contact your PPM Center administrator.
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Figure 8-3. Create New CMQC - QA Test Status Report page
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Table 8-3. Fields on the Create New CMQC - QA Test Status Report page

(page 1 of 7)

Field Name
(*Required)

Description

Summary section

Request Status Displays the current workflow status of the request.
Created By Displays the name of the user who created the request.
*Priority Displays the priority value assigned to the request.
Reviewer Use the auto-complete to select the name of a user to

review the report results.

Reviewer Group

Use the auto-complete to select the name of the security
group to which the review belongs.

Test Scope Overview sec

tion

Use this section to provide information about the
application version, test cycle, and the scope of the
testing effort.

Type the name of the product or application under test in

Application this field.

*\Version _Typg th_e version of the product or application under test
in this field.

*Build Type the development build identifier in this field.

Test Cycle ID T_ype the identifier for the test iteration or cycle in this
field.
Use the auto-complete to select one or more values that

Test Scope

indicate the scope of the testing.
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Table 8-3. Fields on the Create New CMQC - QA Test Status Report page

(page 2 of 7)

Field Name
(*Required)

Description

Quality Center Configuration section

Use this section to provide details on how to connect to
the Quality Center project, and your preferences for how
to process the test status report.

Quality Center Information

*Quality Center
Instance

Type the name of the Quality Center instance in this field.

*QC Username

Type the name of the Quality Center user in this field.
This account is used to retrieve the list of available QC
domains and projects.

QC Password

Type the password of the Quality Center user in this field.

*QC Domain

Type the name of the Quality Center domain in this field.
Only domains that the Quality Center user has access to
are allowed.

*QC Project

Type the name of the Quality Center project from which
to retrieve data in this field. You can only specify projects
to which the Quality Center user has access.

QC Statistics Reference

Identifiers

*Requirement Path

Use the auto-complete to select the test requirement path
provided in the Quality Center project.

*Define Parent
Requirement ID

Type the parent requirement ID in this field. The parent
requirement ID is defined by the request owner in the
specified project. This reference is used to obtain all
information related to requirements coverage, review
status, and test execution.

If requirement ID is set to 0, all requirements in the
project and their sub-nodes are processed. If the
requirement ID is set to a negative number, requirements
and test execution data are not processed.
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Table 8-3. Fields on the Create New CMQC - QA Test Status Report page

(page 3 of 7)

Field Name
(*Required)

Description

Define Parent Test Set
ID

Type the parent test set ID in this field. The request
owner provides the identifier for the test set in Quality
Center's Test Lab module.

*Define Priority Defect
Levels

Use the auto-complete select. The request owner
provides a list of defect priorities. This information is used
to identify high-priority defects and enable better project
risk assessment.

Overall Test Status section

Use this section to select an indicator of application
quality and provide a summary of the results.

Overall Quality Status

From this list, select a value (Green, Yellow, or Red) to
indicate the overall status of the testing effort or results.

Test Status Summary

In this field, you can type a brief summary of the testing
activities and results.

Requirements Coverage

Analysis section

Coverage Status

From this list, select a value (Green, Yellow, or Red) to
indicate the overall status of testing requirements (based
on coverage and review).

Results Analysis

You can type a brief summary of the test requirements
status in this field.

Coverage Statistics

Type the total number of requirements analyzed (under

Total the specified parent requirement ID) in this field.
Passed Type the number of requirements with a direct coverage
status of “Passed” in this field.

Failed Type the number of requirements with direct coverage

status of “Failed” in this field.

Not Covered

Type the number of requirements with a direct coverage
status of “Not Covered” in this field.
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Table 8-3. Fields on the Create New CMQC - QA Test Status Report page

(page 4 of 7)
F'Eﬁlgqtli?g]()a Description
N/A Type the number of requirements with a direct coverage
status of “NA” in this field.
Other In this field, type the number of requirements with all

other direct coverage status values.

Review Statistics

Total

In this field, type the total number of requirement nodes
under and including the specified parent requirement ID.

Reviewed

In this field, type the number of requirements with the
status “Reviewed.”

Not Reviewed

In this field, type the number of requirements with the
status “Not Reviewed.”

Other

In this field, type the number of requirements with all
other review status.

Test Execution Analysis section

Test Status

From this list, select a value (Green, Yellow, or Red) to
indicate the overall status of test development and
execution.

Results Analysis

You can type a brief summary of test execution activities
and results in this field.

Test Execution Statistics

In this field, you can type the total number of unique tests

Total linked to requirements.
Passed In. this field, you can type the number of completed tests
with Passed status.
. In this field, you can type the number of completed tests
Failed . .
with Failed status.
Other In this field, you can type the number of tests pending.
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Table 8-3. Fields on the Create New CMQC - QA Test Status Report page
(page 5 of 7)

F'!Eeqli?:cﬁ Description

Defect Analysis section

From this list, select the red, yellow, or green indicator to

Defect Status reflect application quality based on the defect statistics.

In this field, you can type a brief summary of known

Results Analysis project defects and risks.

In the generated report, this field displays the total
number of defects (with any status) in the specified
Quality Center instance for the selected project,
application, build, and so on.

Overall Total Defects

In the generated report, this field displays the total
number of open defects with a priority level defined as
high in the specified Quality Center instance for the
selected project, application, build, and so on.

Open Priority Defects

In the generated report, this field displays the total
number of defects with the status of Open in the specified
Quality Center instance for the selected project,
application, build, and so on.

Open Defects
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Table 8-3. Fields on the Create New CMQC - QA Test Status Report page

(page 6 of 7)

Field Name
(*Required)

Description

QC Filters

QC filters allow the QA manager to filter only the types of
defects that they wish to report on. The filter name can
include information on application version, defect type,
and so on, to help identify defects that should be
processed for this report.

You can use the following names, conditions, and values
to filter defects:

o Field Name. A name of a defect field or attribute as
specified in the Quality Center project.

e Operator. A comparator for the field name and value
(for example, Equals, Like, In, and so on), a logical
operation between two conditions (for example, AND,
OR) or a grouping of conditions (for example, begin/
end group).

e Available Condition. (Optional) An auto-complete list
of available condition values.

e Actual Condition. A value for the field. If operator is
“In” or “Not In,” then the actual condition must be within
single quotes and delimited by a comma (for example,
“Value,” “ValueB,” “ValueC”) If the operator is “Like” or
“Not Like,” then the value can contain a wildcard (%)
such as %ProjectX%.

For example, if a given Quality Center project is tied to
many application projects, setting the filters lets you
create a report that contains only defects of a certain type
that are specific to a project. (For example, Application =
Application Project A AND Type = Functional.)

You must specify at least one filter for this report.
Otherwise, no query is made and no data are collected.

Total Defects

Total number of defects that match the filter conditions.

Open Priority

Number of defects that are pending (not closed), and that
have priority levels defined as high (based on the Define
Priority Level Defects field).

Open Defects

Number of defects that are pending (not closed).
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Table 8-3. Fields on the Create New CMQC - QA Test Status Report page

(page 7 of 7)

Field Name
(*Required)

Description

Notes section

Notes to be added on
save

Use this field to record any additional notes you want to
save about this QA test status report.

Reference Additions sec

tion

New Reference

From this list, select the type of new reference that you
want to associate with this QA test status report.

Add

Click this button to search for and select the specific
reference (of the type you selected from the New
Reference list) to add.

References to be
added on Save

Field that lists the references you selected to be added
when you submit the request.

Open

Click this button to open and view a reference selected in
the References to be added on Save list.

Remove

Click this button to remove a reference selected in the
References to be added on Save list.

After you submit the request, the Request Creation Confirmed page opens. To
view the newly generated detail page for the project initiation request, click the
Request # link. The project initiation request is routed along its workflow.

All test status update reports are listed chronologically in the Project Overview
page as shown in Figure 8-4. It is considered best practice for the project
manager to issue project status updates on a weekly basis.
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Figure 8-4. CMQC - Quality Status Trending portlet
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The test status report data is also used in multiple PPM Dashboard portlets. For
more information on the quality-related PPM Dashboard portlets, see
Chapter 7, Viewing and Tracking Project Progress and Quality, on page 101.
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9 QA Test Status Reports

Overview of CMQC - QA Test Status Reports

The QA test status report is used by the project, development, and QA teams to
track the progress of the testing effort and application quality. The report is
linked to a single Quality Center project. It queries the Quality Center project
for data on requirements coverage, review status, test execution progress, and
defects trends.

QA test status report results are distributed to the stakeholders in various PPM
Dashboard portlets. It is important that the QA manager run the test status
report on a regular basis to provide visibility into the application quality levels,
identify trends, and resolve any potential issues before they threaten the
application's business success.

CMQC provides the workflow to create a status report that includes several
major quality indicators. If you need to collect additional quality metrics from
the Quality Center project, the QA manager can contact the PPM Center
administrator, who can then extend the test status report’s capabilities.
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Figure 9-1 shows the workflow that the CMQC - Test Status Report request
follows. Table 9-1 lists descriptions of the individual steps in this workflow.

Figure 9-1. CMQC - QA Test Status Report workflow
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Table 9-1. CMQC - QA Test Status Report workflow steps

Workflow Step Description
1 New A new QA test status report is submitted for
' processing.
2. | Initialize Fields QA test status report fields are initialized.

3. | Enter QC Configuration

Details on the Quality Center instance, domain,
and project are provided. Test results will be
retrieved from this project.

Validate QC Project
Connectivity

An execution step that validates the connection
to the specified Quality Center project.

5. | Update Quality Status

The creator or reviewer may manually update
the test results or automate the retrieval of test
results from the target Quality Center project. (If
retrieval is automated, the user validates the
results before submitting for review.)

6. | Updating Status Report

This execution step connects to the target
Quality Center project and retrieves data on
requirements coverage, requirements review
status, test execution status, and defect
statistics. Information is only retrieved for
metrics that have defined filters or
prerequisites.

7. | Approve Report

An assigned reviewer (for example, a QA
manager, development manager, or project
manager) approves the test status report.

8. Closed

The test status report is complete.

Creating a CMQC - QA Test Status Report Request

QA Test Status Reports

To submit a QA test status report request:

1. Log on to PPM Center.

2. From the menu bar, select Open > Center Management > Quality
Management > Create Test Status Report.
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The Create New CMQC - QA Test Status Report page opens.
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QA Test Status Reports

3. In each section, complete the required fields (marked with a red asterisk)
and any of the optional fields for which you want to provide information.

Table 9-2 lists descriptions of all of the fields on the page.

Additional information helps all stakeholders gain a better understanding of a
project. For information about any of the fields on this page, select the Help with
CMQC - QA Test Status Report link in the upper-left corner of the page.

4. Click Submit.

PPM Center can be configured so that you can save the request before you
submit it. To have this feature enabled, contact your PPM Center administrator.

Table 9-2. Fields on the Create New CMQC - QA Test Status Report page

(page 1 of 7)

Field Name
(* Required)

Description

Summary section

Displays the current workflow status of the report

Status
request.
Created By Displays your name as originator of the request.
From this list, you can replace the default (Normal), with
*Priority a value that more closely indicates the relative
importance of this report.
. . From the list, assign a resource to review the report
Reviewer

results.

*Reviewer Group

From the auto-complete list, select the name of a
security group to review the report results.

Test Scope Overview section

Type the name of the product or application under test

Application in this field.
“Versi Type the version number of the product or application
ersion T
under test in this field.
*Build Type the development build identifier in this field.
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Table 9-2. Fields on the Create New CMQC - QA Test Status Report page

(page 2 of 7)
Field Name -
(* Required) Description
Test Cycle ID Type the identifier for the test iteration or cycle in this
field.
From the auto-complete list, select one or more values
Test Scope

that indicate the scope of the testing report.

Quality Center Configuration section

Use this section to provide details on how to connect to
the Quality Center project, and your preferences for
how to process the test status report.

Quality Center Information

Type the name of the Quality Center instance in this

Quality Center Instance fiold.

Type the name of the Quality Center user in this field.
*QC Username This account is used to retrieve the list of available QC
domains and projects.

Click Enter, and then, in the PPM Center password

QC Password window, type and then confirm a new QC password.

Type the name of the Quality Center domain in this
*QC Domain field. You can only specify domains to which the Quality
Center user has access.

Type the name of the Quality Center project from which
*QC Project to retrieve data in this field. You can only specify
projects to which the Quality Center user has access.

QC Quality Statistics Reference Identifiers

Use the auto-complete to specify the path to the Quality

Requirement Path Center requirements.
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QA Test Status Reports

Table 9-2. Fields on the Create New CMQC - QA Test Status Report page

(page 3 of 7)

Field Name
(* Required)

Description

*Define Parent
Requirement ID

Type the parent requirement ID in this field. The parent
requirement ID is defined by the request owner in the
specified project. This reference is used to obtain all
information related to requirements coverage, review
status, and test execution.

If requirement ID is set to 0, all requirements in the
project and their sub-nodes are processed. If the
requirement ID is set to a negative number,
requirements and test execution data are not
processed.

Define Parent Test Set ID

Type the parent test set ID in this field. The request
owner provides the identifier for the test set in Quality
Center’s Test Lab module.

*Define Priority Defect
Levels

Use the auto-complete to select. The request owner
provides a list of defect priorities. This information is
used to identify high-priority defects and enable better
project risk assessment.

Overall Test Status section

Use this section to select an indicator of application
quality and provide a summary of the results.

Overall Quality Status

From this list, select a value (green, yellow, or red) to
indicate the overall status of the testing effort or results.

Test Status Summary

In this field, you can type a brief summary of the testing
activities and results.

Requirements Coverage Analysis section

Coverage Status

From this list, select a value (Green, Yellow, or Red) to
indicate the overall status of testing requirements
(based on coverage and review).

Results Analysis

You can type a brief summary of the test requirements
status in this field.
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Table 9-2. Fields on the Create New CMQC - QA Test Status Report page

(page 4 of 7)

Field Name
(* Required)

Description

Coverage Statistics

Type the total number of requirements analyzed (under

Total the specified parent requirement ID) in this field.

Passed Type the number of requirements with a direct
coverage status of “Passed” in this field.

Failed In this field, type the number of requirements with direct

coverage status of “Failed.”

Not Covered

In this field, type the number of requirements with a
direct coverage status of “Not Covered.”

N/A

In this field, type the number of requirements with a
direct coverage status of “NA.”

Other

In this field, type the number of requirements with all
other direct coverage status values.

Review Statistics

In this field, type the total number of requirement nodes

Total under and including the specified parent requirement
ID.
Reviewed In this field, type the number of requirements with the

status “Reviewed.”

Not Reviewed

In this field, type the number of requirements with the
status “Not Reviewed.”

Other

In this field, type the number of requirements with all
other review status values.

Test Execution Analysis section

Test Status

From this list, select the indicator (green, yellow, or red)
that best reflects the overall status of test development
and execution.

Results Analysis

You can type a brief summary of test execution
activities and results in this field.
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Table 9-2. Fields on the Create New CMQC - QA Test Status Report page

(page 5 of 7)

Field Name
(* Required)

Description

Test Execution Statistics

In this field, you can type the total number of unique

Total tests linked to requirements.
Passed In_ this field, you can type the number of completed tests
with Passed status.
. In this field, you can type the number of completed tests
Failed . .
with Failed status.
Other In this field, you can type the number of tests pending.

Defect Analysis section

Defect Status

From this list, select the red, yellow, or green indicator
that best reflects current application quality based on
the defect statistics.

Results Analysis

In this field, you can type a brief summary of known
project defects and risks.

Overall Total Defects

In the generated report, this field displays the total
number of defects (with any status) in the specified
Quality Center instance for the selected project,
application, build, and so on.

Open Priority Defects

In the generated report, this field displays the total
number of open defects with a priority level defined as
high in the specified Quality Center instance for the
selected project, application, build, and so on.

Open Defects

In the generated report, this field displays the total
number of defects with the status of Open in the
specified Quality Center instance for the selected
project, application, build, and so on.

QA Test Status Reports
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Table 9-2. Fields on the Create New CMQC - QA Test Status Report page

(page 6 of 7)

Field Name
(* Required)

Description

QC Filters

QC filters allow the QA manager to selectively filter for
the information to include in the QA test status report.
The filter can be used to specify application version,
defect type, and so on, to help capture the data to be
processed for the report.

You can use the following names, conditions, and
values to filter defects:

o Field Name. A name of a defect field or attribute as
specified in the Quality Center project.

e Operator. A comparator for the field name and value
(for example, Equals, Like, In, and so on), a logical
operation between two conditions (for example,
AND, OR) or a grouping of conditions (for example,
begin/end group).

e Available Condition. (Optional) An auto-complete
list of available condition values.

e Actual Condition. A value for the field. If operator is
“In” or “Not In,” then the Actual Condition must be
within single quotes and delimited by a comma (for
example, “Value,” “ValueB,” “ValueC”) If operator is
“Like” or “Not Like,” then the Actual Condition value
can contain a wildcard (%) such as %ProjectX%.

For example, if a given Quality Center project is tied to
many application projects, setting the filters Lets you
create a report that contains only defects of a certain
type that are specific to a project. (For example,
Application = Application Project A AND Type =
Functional.)

You must specify at least one filter for this report.
Otherwise, no query is performed and no data are
collected.

Total Defects

Total number of defects that match the filtering
conditions.
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QA Test Status Reports

Table 9-2. Fields on the Create New CMQC - QA Test Status Report page

(page 7 of 7)
Field Name -
(* Required) Description
Number of defects that are pending (not closed), and
Open Priority that have priority levels defined as high (based on the
Define Priority Level Defects field).
Open Defects Number of defects pending (not closed).

Notes section

Notes to be added on Use this field to record any additional notes you want to
save save about this QA test status report.

Reference Additions section

From this list, select the type of new reference that you

New Reference want to associate with this QA test status report.

Click this button to search for and select the specific
Add reference (of the type you selected from the New
Reference list) to add.

References to be added | Field that lists the references you selected to be added
on Save when you submit the request.

Click this button to open and view a reference selected

Open in the References to be added on Save list.

Click this button to remove a reference selected in the

Remove References to be added on Save list.

The new QA test status report request is routed along its workflow.

After you submit the request, the Request Creation Confirmed page opens. To
view the newly-generated detail page for the project initiation request, click the
Request # link.

All test status update reports are listed chronologically in the CMQC - Quality
Status Trending portlet, as shown in Figure 9-2. It is considered a best practice
for the project manager to issue project status updates weekly.

163



Figure 9-2. CMQC - Quality Status Trending portlet
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QA test status report results are used in multiple PPM Dashboard portlets. For
more information on the quality-related portlets, see Chapter 7, Viewing and
Tracking Project Progress and Quality, on page 101.
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10 Managing Quality Center of Excellence
Administrative Activity

Overview of Managing CoE Administration

The Quality Center of Excellence includes a set of internal administrative
activities that must follow a defined series of workflow steps to ensure
successful processing and resolution. CMQC provides administrative request
types and workflows for managing these activities, which are:

e Quality Center instance registration (see Quality Center Instance
Registration Requests on page 165)

e Quality Center project and user administration (see QC Administrative
Requests on page 169)

e Requesting service from IT (see Creating CMQC - IT Service Requests
on page 184)

The request types that you can use to manage these activities are addressed in
detail in the following sections.

Quality Center Instance Registration Requests

To register a Quality Center instance, you submit a CMQC - QC Instance
Registration request. Once a Quality Center instance is registered, it can be
referenced by other types of requests (CMQC - QC Project Administrative
requests, CMQC - QC User Administrative requests, CMQC Testing Project
requests, and so on) and portlets to perform queries and actions.
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To register a QC instance, you must provide QC connection information for both the
QC database and the QC site administrator.

CMQC - QC Instance Registration requests are routed to CMQC’s
administrative or operations teams and are handled by either an application
administrator for Quality Center or a systems administrator. CMQC - QC
Instance Registration requests follow the workflow shown in Figure 10-1 and
described in Table 10-1.

Figure 10-1. CMQC - QC Instance Registration workflow
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Table 10-1. CMQC - QC Instance Registration workflow steps

Workflow Step Description
New A new Quality Center registration request is submitted
for processing.
Information provided for the Quality Center instance is
Verify Connectivity tested and verified. If both the application server and

database details are valid, the check passes.

QC Instance Active

Registered instance has been validated and is
available for referencing and use in various requests
that require Quality Center instance information.

Set QC Instance
Inactive

Sets the active state of the Quality Center instance to
“unavailable.” The instance cannot be referenced by
new requests.

The instance has been temporarily suspended and

QC Instance cannot be used in new requests. This typically
Suspended happens while maintenance is performed on the
registered Quality Center instance.
Checks to determine whether the Quality Center
Check Dependency instance is being used by a project or request. Quality

Center instances that are in use cannot be modified.

Retry Dependency
Check

The administrator can either retry the dependency
check in order to perform an update, cancel the
update request and return to active state with existing
configuration, or suspend the Quality Center instance.

Set QC Instance

The administrator updates the instance configuration.
If an error occurs, the administrator checks the status
message, corrects the problem, and then resubmits
so that the instance information can be validated.

To create and submit a CMQC - QC Instance Registration request:

1. Log on to PPM Center.

) For information on how to log on to PPM Center, see the Getting Started guide for

PPM Center.
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2. From the menu bar, select Open > Center Management > Administrative
Requests > Register a QC Instance.

The Create New CMQC - QC Instance Registration page opens.

2| Help with CMQC - QC Instance Registration

Create New CMQC - QC Instance Registration

Expend il Collspse a1l

Submit Cancel

=l Header

=l Instructions

® Use this form to provide all the information related to a Quality Center Instance.

 The fields with * require your input.

e The information provided within this reguest will be used to perform various operations required by other request types and

portiets that reference this instance.

B summary

Created By: Admin User

Assigned Group:

L 1

Workflow Status: Not Submitted

=l Details

Bl Registration Information

“Quality Center Instance
Name:

Bl Application Server Detail

“ac Admin Site Url ‘
Address:

“QC User Url Address: |

“Qc Admin User:

L 1

= Site Admin Database Detail

ORACLE A

“Database Type:

Database Instance:

“DB Admin Username:

“JDBC Urk: [

= Default Preferences

Preferred New Project

Dotanase: . =
breferredUser Tomiospaces ||

E]
| view url|
| view uRl|
QC Admin Password: (blank) e
E|
“Database Server llame: 1
*schemal/Catalog Name: l:l
DB Admin Password: (blank) [DEaEee
a2

Preferred TEMP
Tablespace:

L 1

# Notes

# References

Submit Cancel
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3. Complete all required fields (marked with a red asterisk), if any, in each
section of the page.

) For help on the request fields, select the Help with CMQC - QC Instance
Registration link at the top left of the page.

4. Complete any optional fields that provide users with additional information
they might find useful.

5. Click Submit.

Your PPM Center administrator can configure PPM Center so that you can save
) requests before you submit them. To have this feature enabled, contact your PPM
Center administrator.

The Request Creation Confirmed page opens.

[ Project and Portfolio Management Center

Dashboard - Front Page > Create New CMQC - QC Instance Registration > Dashboard - Front Page > Req #30791: Created, Submitted

Request Creation Confirmed

The following request has been created and submitted:

Request#® 20781 Description:  QC44UWestlab

‘Request Type: v| Create

6. To open the detail page for the new request, click the number displayed in
the Request # field.

The submitted QC Instance Registration request is routed along the workflow
shown in Figure 10-1 on page 166.

The information you provided in the request can now be used to perform
various operations required by other request types and portlets that reference
this Quality Center instance.

QC Administrative Requests

A Quality Center Administrative request is a request for service on a specific
Quality Center instance or project. You can create two types of Quality Center
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administrative requests to carry out tasks that Quality Center administrators
perform frequently.

To automate Quality Center project administration tasks, you create a CMQC -
QC Project Administrative request. To automate Quality Center user
administration tasks, you create a CMQC - QC User Administrative Request.
Task automation for requests of these types is driven by approvals from QC
administrators.

Use CMQC - QC Project Administrative requests to automate:
e C(Creating a project based on a Quality Center template
e Copying an existing project

e Synchronizing project configuration and customization with another
project or template

Use CMQC - QC User Administrative requests to automate:

e (Creating a user account

e Updating a user account

e Resetting passwords for user accounts

e Adding resources to a Quality Center project or group

e Removing resources from a Quality Center project or group

When you create these types of requests, you specify the Quality Center
instance you want to use as well as the project and the domain.

Quality Center administrative requests are routed to Center of Excellence
administrative or operations teams to be handled by either a Quality Center
application administrator or a systems administrator. Both CMQC - QC Project
Administrative and CMQC - QC User Administrative type requests follow the
workflow shown in Figure 10-2 and described in Table 10-2.
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Figure 10-2. CMQC - QC Administrative Request workflow
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Table 10-2. CMQC - QC Administrative Request workflow steps (page 1 of 2)

Workflow Step

Description

New

A new QC administrative request is submitted for
processing.

Assign Resource (with
optional Auto Assign)

If a resource was not automatically assigned to the
request, the CoE IT service team manually assigns a
resource to the request.

Escalate Request

The request creator escalates the request by
increasing its priority and notifying CoE
administration that the request requires attention.

Check & Update
Priority

If the request is escalated, this step checks and
updates the request priority.

Escalated

The request is escalated, and action must be taken to
expedite its resolution. The administrative manager
may assign additional resources to help resolve the
issue.

Cancelled

The request is cancelled by its creator.

Process Admin
Request

The assigned administrator verifies the information
provided in the request. If the request operation is
permitted based on CoE policies, the administrator
can either perform the task manually or automate the
task. Task automation allows administrators to
quickly process operations that are frequently
requested.

Additional Information
Requested

The request creator requires additional information
so that the request can be processed correctly. This
step is also used to get necessary feedback or
clarification on the task.

Automated Processing

The tasks defined in the administrative request are
automated. It is important to ensure that all required
information is provided in the appropriate section for
the task.

10.

Manual Processing

The administrator assigned to the task performs the
requested task manually. This may be required
based on the complexity of the request.
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Table 10-2. CMQC - QC Administrative Request workflow steps (page 2 of 2)

Workflow Step Description

11. | Reset Error Field The task Status field is cleared.

The assigned administrator is allowed to validate the
task performed, especially if it was automated. The

12.| Validate Results administrator can complete or audit the task

manually.
13. | Passthru A pass-through step.
14. | Resolution Approval A submitted resolution is pending requestor approval.

A submitted resolution is pending requestor
feedback. The requestor can complete the feedback
section to provide service-level metrics.

If feedback is not provided within the configured
timeout interval (typically 14 days), the request is
automatically closed.

15. | Request Feedback

16. | Close (Success) The request was closed with success.

Creating CMQC - QC User Administrative Requests

To create and submit a CMQC - QC Administrative request:

1. Log on to PPM Center.

) For information on how to log on to PPM Center, see the Getting Started guide for
PPM Center.

2. From the menu bar, select Open > Center Management > Administrative
Requests > QC User Administration.

The Create New CMQC - QC User Administrative Request page opens.

Managing Quality Center of Excellence Administrative Activity 173



?| Help with CMQC - QC User Administrative Reguest

Create New CMQC - QC User Administrative Request

Expand Al Collapse All Submit Cancel

= Header

# [nstructions

B Summary

Workflow Status: Mot Submitted

Created By: Admin User *Priority:

Requested For: l:l Contact Phone: Contact Email:
Company:
CC List: \ |
“Description: ‘ |
= Details

= Administrative Type

“Target QC Instance: | [ ]

Requested Task: New/Update/Reset User

B User Admi

“Domain Name: | | j

“Project Name: |

=l Users:

(No Entries)

Modify Table|

Additional Instructions

Attachment {ne document attached) Add

# Motes

# References
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3. Complete the following fields in the Summary section:

Field Name
(*Required)

Description

*Priority

To change to a priority value other than Normal, select a
different value from this list.

Requested For

In PPM Center, contacts are resources used as a point
of reference or information. If you are submitting the
request on behalf of a PPM Center contact, select the
contact’s name from the auto-complete list.

After you select a contact the Contact Phone, Contact
Email, and Company fields will be populated
automatically if the contact’s phone number and email
address have been provided. For more information
about contacts, see the HP Demand Management
Configuration Guide.

CC List

From the auto-complete list, select the email IDs of
users to be copied on this request.

*Description

Type a short description of this request.

4. In the Administrative Type section, from the auto-complete list for the
Target QC Instance field, select the Quality Center instance to use.

5. In the User Administration section, complete the following required fields:

a. From the auto-complete list for the Domain Name field, select the target
Quality Center domain.

b. From the auto-complete list for the Project Name field, select the target
Quality Center project.

6. To select resources to add to, remove from, or update for the selected

project:

a. In the Users section, click Modify Table.

The Users window opens.
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[ (D ] Close Window X

[® s Export to Excel

Users:
Seq News | Existing User: | First Hame: Last Name: Email Address: Project Operation: | GC Group Name: Group Operation:
& N
¥ Ho Entries
Check All Clear All Add Edit Copy Delete
Done cancel
b. Click Add.
The Users: New Entry window opens.
ﬂa Close Window X
Users: - New Entry
Instance Name: Domain Name: Project Hame:
Existing Users: j New | Existing User: Make Admin: w
First Hame: Last Name: Email Address:
Project Operation: w Group Operation: v Qc Group Name: [
Status: Status Notes:
Add Another Raeg
Add ‘ Cancel

c. Do one of the following:

e To select an existing resource, use the Existing Users
auto-complete.

e To create a new PPM Center user account, in the New / Existing
User field, type a username for the resource.

If you are adding a new resource, the remaining enabled fields are
now required.

d. In the First Name field, type the first name of the resource.

e. In the Last Name field, type the last name of the resource.
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f. In the Email Address field, type the email address of the resource.

) If you are adding a new resource, then after you submit the request, a
password is generated for the new resource and sent to this email address.

g. From the Project Operation list, select one of the following:
e To add this resource to the selected project, select ADD.

e To update the information for an existing resource with the
information you add in this window, select UPDATE.

e To remove this resource from the selected project, select REMOVE.

e If you are adding a resource to the system, but not to the selected
project, select NONE.

h. From the Group Operation list, select one of the following:
e To add the resource to a Quality Center security group, select ADD.

e To remove the resource from a Quality Center security group,
select REMOVE.

e Ifyou are adding the resource to the system, but not to any security
groups, select NONE.

i. To specify the Quality Center security group to add the resource to, or
remove the resource from, use the QC Group Name auto-complete.

j. To designate this resource a Quality Center administrator, from the
Make Admin list, select TRUE. Otherwise, select FALSE.

k. To add this user to the Users section and close the Users - New Entry
window, click Add. Otherwise, to select another user, click Add
Another.
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After you finish adding users, the Users window lists your selections.

(D] [Close Window x
@ Export to Excel
Users:
Seq New | Existing User: | First Name: Last Hame: Email Address: Project Operation: QC Group Name: Group Operation:
0o gdavis Gladys Davis gdavis@acme.com ADD QATester ADD
H 2 mary_qc Mary River eriver@acme.com ADD QA Manager ADD
o 3 alex_qc Alex Smith asmith{@acme.com ADD QATester ADD
B 4 porcutt Peter Qreutt porcutt@acme.com REMOVE Developer REMOVE
O 5 JAM Jean Michaels JAN@acme.com UPDATE Project Manager NONE
Check All Add
Done Cancel

7. Click Done.

The Users section of the Create New CMQC - QC User Administrative Request
page does not list the selected users until you submit the request. Your

) administrator can configure PPM Center so that you can save requests before you
submit them. To have this feature enabled, contact your PPM Center
administrator.

8. Click Submit.
The Request Creation Confirmed page opens.

9. To open the detail page for the new request, click the number displayed in
the Request # ficld.

The submitted CMQC - QC User Administrative request is routed along the
workflow shown in Figure 10-2 on page 171.

Creating CMQC - QC Project Administrative Requests

To create and submit a CMQC - QC Project Administrative request:

1. Log on to PPM Center.

) For information on how to log on to PPM Center, see the Getting Started guide for
PPM Center.

2. From the menu bar, select Open > Center Management > Administrative
Requests > QC Project Administration.
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The Create New CMQC - QC Project Administrative Request page opens.

[} Project and Portfolio Management Center SiGN OUT

Dashboard - Front Page > Search Requests > Search Resulls > Request #30040 > Create New CHWQC - QC Project Administrative Request

] Help v

Project A Reguest

Create New CMQC - QC Project Administrative Request

 — Submit Cancel

= Header

= Instructions

 Use this form to perform all types of Project or User Administration Task in Quality Center.
+ The fields with * require your input

H Summary

Workflow Status: Not Submitted
Created By: Admin User “Priority;
Requested For: I | Contact Phone: Contact Emaili

Company:

cC List: [ |

“Description: [ |

£ Details

S Administrative Type

“Target QC Instance: [ J

‘Requested Task: [ |

“Task Options: [ |

B Project Administration

Target: Existing Domain: [ I |

HNewi Existing Domain: [ |

Existing Project: [ | =

Newi Existing Project: [ |

Template: Domain: [ | =
Project: [ | =
Project Options: [ 1=

Additional Instructions:

Attachment: (no document attached

DB Admin User: /1 DB Admin Password: (blank) [CEntee
Space:

# Notes

# References
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3. Complete the following fields in the Summary section:

{"EEEq:li?eTﬁ Description

To change to a priority value other than Normal, select a

Priority different value from this list,

In PPM Center, contacts are resources used as a point
of reference or information. If you are submitting the
request on behalf of a PPM Center contact, then from
the auto-complete list, select the contact’'s name.

After you select a contact the Contact Phone, Contact
Email, and Company fields will be populated
automatically if the contact’s phone number and email
address have been provided. For more information
about contacts, see the HP Demand Management
Configuration Guide.

Requested For

From the auto-complete list, select the email IDs of

CC List users to be copied on this request.

*Description Type a short description of this request.
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4. Complete the following fields in the Administrative Type section:

Field Name
(*Required)

Description

*Target QC
Instance

From the auto-complete list, select the name of the
Quality Center instance on which the administrative
tasks are to be performed.

*Requested
Task

From the auto-complete list, select one of the following
tasks to perform:

e To create a new and empty Quality Center project,
select Create Empty Project.

e To create a new Quality Center project from a
template, select Copy Project From Template.

e To synchronize project configuration and
customization with another project or template, select
Synchronize Project.

e To perform a customized task on Quality Center,
select Other.

*Task Options

From the auto-complete list, specify the task options to
include. The selections available depend on the
requested task you selected.

Depending on the requested task you selected, various combinations of
fields in the Project Administration section are optional or required.
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5. Complete the following fields in the Project Administration section:

Field Name
(*Required)

Description

Target

Existing Domain

From the auto-complete list, specify an existing
Quality Center domain.

New / Existing
Domain

If you cannot locate the target domain you want
using the Existing Domain auto-complete, then type
the domain name in this field.

Existing Project

If the request task is to either the create a new
project or copy a project from a template, then from
the auto-complete list specify an existing Quality
Center project as the target project.

New / Existing

If you cannot locate the target project you want in the
auto-complete list for the Existing Project field, then

Project type the project name in this field.
Template
If you are creating a project based on a template or
. synchronizing project configuration and
Domain L .
customization, then from the auto-complete list,
specify the source or template domain.
If you are creating a project based on a template or
Project synchronizing project configuration and

customization, then from the auto-complete list,
specify the source or template project.

Additional Informatio

n

From the auto-complete list, select available options

Project Options for the selected task.
Additional In this field, type any additional required steps to be
Instructions performed.
To attach a document that contains information
required to complete this administrative request, in
Attachment

this field, click Add, and then browse for and select
the document.
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completed by the Quality Center administrator:

Field Name -
(*Required) Description
From the auto-complete list, select a registered
DB Server database server.
Name Note: A database server must be registered in Quality

Center before it can be available to create new projects.

DB Admin User

Specify a database administrator username to use to
create a new Quality Center project database schema.

To specify the password that corresponds to the

DB Admin selected database administrator username, to the right
Password of this field, click Enter and then type and confirm the
password.
(Oracle database only) If you are creating or copying a
project, this field displays the name of the user
Oracle User . . . .
Table Space tablespace in which the prOJect' database schema is to
be created. You can select a different user tablespace
from the auto-complete list.
(Oracle database only) This field displays the name of
Oracle TEMP the temporary tablespace that the Quality Center project
Table Space is to use. You can select a different temporary

tablespace from the auto-complete list.

added on save field.

. Click Submit.

Your administrator can configure PPM Center so that you can save requests

6. In the Project Administration Options section, the following fields are to be

7. To save additional information on this request, type it into the Notes to be

before you submit them. To have this feature enabled, contact your PPM Center

administrator.

The Request Creation Confirmed page opens.

. To open the detail page for the new request, click the number displayed in
the Request # field.

The submitted CMQC - QC Project Administrative request is routed along the
workflow shown in Figure 10-2 on page 171.
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Creating CMQC - IT Service Requests

184

The IT Service request supplied by CMQC is used to obtain general
administrative or IT support. These requests are routed to the CMQC'’s
administrative or operations teams and are handled by a Quality Center
application administrator, PPM Center administrator, or systems administrator.
Unlike support requests, IT service requests focus on items such as application
software, hardware configuration, upgrades, and installations

The IT service request follows the workflow shown in Figure 10-3 and
described in Table 10-3.

Figure 10-3. CMQC - IT Service Request workflow
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Table 10-3. CMQC - IT Service Request workflow steps

Workflow Steps

Description

1. | New

A new IT Service request is submitted.

2. | Assign Request

A notification email is sent to CoE administrators
requesting assignment of the request.

The request is assigned to the appropriate
resources. Typically, the administrative resource to
whom it is assigned coordinates the tasks with other
administrative resources.

Work In Progress
3. .
(Engineer)

The assigned engineer performs the required tasks
to process and address the request requirements.

4 Work In Progress
" | (Requestor)

The requestor is provided the opportunity to track
the request and, if necessary, escalate it.

5. | Information Requested

An email notification is sent to the request owner,
asking for additional information or clarification.

6. | Resolution Approval

The requestor approves a submitted resolution.

7. | Passthru

A pass-through step.

8 Provide Request
" | Feedback

The requestor completes the feedback section to
provide CoE management with service-level. If
feedback is not provided within the configured
timeout interval (usually 7 days), the request is
automatically closed and a notification email is sent
to the requestor with the request status.

9. | Escalated

The request is escalated. It is either reassigned or
re-prioritized, so that the administrative team, or
project and technical account managers take action
to resolve it. A notification email is sent to CoE
administrators to ask that the escalated request be
handled.

10. | Close (Success)

The request is closed with a successful result.

11. | Cancelled

The requestor cancelled the request, or the did not
respond to the demand for additional information.
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To create a CMQC - IT Service request:
1. Log on to PPM Center.

) For information on how to log on to PPM Center, see the Getting Started guide.

2. From the menu bar, select Open > Center Management > Administrative
Requests > IT Service Request.

The Create New CMQC - IT Service Request page opens.

Expend Al Collapse Al Submit Cancel

= Header
E Instructions
& Use this form to submit any IT related problems to the Administrative Center.
with * require your input.
€ provide as much information as possible for a speedy resolution.
contact info shown below is incorrect please provide correct contact info in notes section below so that the user profie
can be updated.
= General Information
Request Status: New

Created By: Admin User Priority: v
Requested For: El Contact Phone: Contact Email:
Company: El Department: E
CC List: =
Assigned Group: = Assigned To: &

Sl Project Reference
Master Project i

=l Details

=l Request Details
“Category: HH *Sub-Category: i Topic: is
Date Needed: =
“Description:
Request Details:

Request Attachments: (no document attached) Add

# MNotes

# References

Submit Cancel
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3. (Optional) To provide users with additional information they might find
useful, you can complete the following fields in the General Information

section:
Field Name Description
. From this list, select a value to indicate the relative
Priority

importance of the request.

Requested For

If you are submitting the request on behalf of another
resource, then from the auto-complete list, select the
username for that resource.

Contact Phone

If you are submitting the request on behalf of another
resource, type the phone number of the resource in this
field.

Contact Email

If you are submitting the request on behalf of another
resource, type the email of the resource in this field.

CC List

From the auto-complete list, select the email IDs of
users to be copied on this request.

Assigned Group

From the auto-complete list, select a security group to
handle this request.

Note: The security group you select determines which
names are available in the Assigned To field.

Assigned To

From the list, select a specific engineer to handle this
request.

4. In the Project Reference section, you can use the Master Project
auto-complete to specify a project that is associated with this request.
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5. In the Request Details section, complete the following fields:

(Fiﬁfq'}ﬁ’g‘f Description
*Category From the auto-complete list, specify the category to

which this IT service request belongs.

From the auto-complete list, specify the sub-category to

Sub-Category which this IT service request belongs.

From the auto-complete list, select a topic that describes

Topic this IT service request.

Using the date chooser, specify the date by which this IT

Date Needed ;
service request must be resolved.

In this field, type a short description of this IT service

*Description
request.

To provide more detailed information about the issue to

Request Details be addressed, type it into this field.

To attach a supporting document or image file that might
help clarify or resolve this issue, in this field, click Add,
and then browse to and select the file.

Request
Attachments

6. To save additional notes related to this request, type them into the Notes to
be added on save field.

) For help on the request fields, select the Help with CMQC - IT Service Request
link at the top left of the page.

7. Click Submit.

Your administrator can configure PPM Center so that you can save requests
) before you submit them. To have this feature enabled, contact your PPM Center
administrator.

The Request Creation Confirmed page opens.

8. To open the detail page for the new request, click the number displayed in
the Request # ficld.

The submitted CMQC - IT Service request is routed along the workflow shown
in Figure 10-3 on page 184.
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